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1 Welcome to the Clay Tablet Connector for Sitecore

1.1 Terminology

1 Welcome to the Clay Tablet Connector for Sitecore
Welcome to the Clay Tablet Connector for Sitecore ("Connector"). This is Clay Tablet’s connector between
Sitecore and the Clay Tablet Platform.
If you have the Special Edition for Lionbridge Freeway, you can automate sending and retrieving content
from Sitecore directly to and from Freeway.
If you have the Special Edition for Lionbridge onDemand, you can automate sending and retrieving content
from Sitecore directly to and from onDemand.

1.1 Terminology
Amazon AWS

Amazon Web Services. A suite of web application products developed and sold by
Amazon.com. Clay Tablet uses various AWS offerings in order to leverage their infrastructure
and build rich, dynamic solutions for its customers, specifically, the Clay Tablet Platform. For
details, see http://aws.amazon.com.

Amazon S3

Amazon Simple Storage Service. For details, see: http://aws.amazon.com/s3/. The
Connector and the Clay Tablet Platform use Amazon S3 to provide temporary storage
services for the content sent to and from translation.

Amazon SQS

Amazon Simple Queue Service. For details, see: http://aws.amazon.com/sqs/. The
Connector uses Amazon SQS to provide Message Queue Services.

Asset

Any content or document being sent for translation, including metadata. Assets are created
by the Connector.

Clay Tablet
(CTT)

Clay Tablet Technologies, the corporate entity that publishes the Clay Tablet Connector and
the Clay Tablet Platform.

Clay Tablet
Connector for
Sitecore
("Connector")

The connector software that Clay Tablet Technologies has developed and provides, which
plugs into your Sitecore CMS to provide connectivity to our hosted Platform. In this
document it is referred to as the Connector. This is the software you are installing and
configuring as you work through this document.

Clay Tablet
Platform

The hosted (IaaS) connectivity platform that receives and routes content from content
systems, including content management systems (CMSs), to translation providers and back
during implementation. Clay Tablet Technologies configures the Platform based on the
number and nature of systems involved in your system architecture.

CT3

Legacy branding term that refers to the Connector.

Freeway

The name of the Lionbridge translation portal for submitting content to and retrieving
content from the Lionbridge translation provider.
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FTP Server

File Transfer Protocol (FTP) is a standard network protocol used to transfer files from one
host to another host over a TCP-based network, such as the Internet. Translation providers
may receive and send files for translation using an FTP server.

IaaS

Infrastructure as a Service. The Clay Tablet Platform is an IaaS, because it is a hosted
platform.

Keys

The Connector uses keys to establish a secure, discrete connection between the Connector
instance and the Platform.
Very important: Do not copy the CMS address keys to multiple Sitecore instances, because
this is a violation of the Clay Tablet License Agreement. Using the same CMS address keys on
multiple Sitecore instances will cause the Connector to behave unexpectedly, which can
result in lost translation content, orphaned projects, and inaccurate translation status
reports. Clay Tablet will support technical issues caused by duplicating or incorrectly
installing CMS address keys only on a time and materials basis.

Lionbridge

A translation provider.
The publisher of the Freeway translation portal. Users connect to the Freeway translation
portal to submit content to and retrieve content from the Lionbridge translation
provider.
The publisher of the onDemand translation platform.

MT

Machine translation. The translation provider can be a machine translation service, such as
Google Translate.

On-Premise
Platform

A version of the Clay Tablet Platform that is hosted and managed by the Clay Tablet client,
instead of hosted on AWS by Clay Tablet.

onDemand

The name of the Lionbridge translation platform. For more information, see
https://ondemand.lionbridge.com.

Producer

CMS or another system that sends content or documents out for translation. In this case,
this is your Sitecore Content Editor.

Provider

A provider of translation services. The delivery of assets to the provider may be via an
FTP server or a TMS connector.

Support
Asset

Supporting documents and their metadata. Support assets are not translated by the
translation provider, but they provide helpful context for the translator.

TMS

Translation management system that the translation provider users.
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1.2 About the Clay Tablet Translation Platform

1.2 About the Clay Tablet Translation Platform
Clay Tablet’s translation connectivity platform is the easiest, most flexible way to integrate content systems,
including content management systems (CMSs) and other content producers, with translation providers and
translation technologies.
Clay Tablet Platform is the hosted (IaaS) connectivity platform that receives and routes content from content
management systems to translation providers and back, including to Lionbridge via Freeway or onDemand. It is
hosted on Amazon Web Services (AWS). During implementation, Clay Tablet Technologies configures the
Platform for your translation solution, based on the translation providers or systems you use. The Clay Tablet
Platform uses the following services on AWS:
S3 (Amazon Simple Storage Service), which provides storage services for the content sent to and from
translation.
SQS (Amazon Simple Queue Service), which provides message queue services.
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1.3 How the Clay Tablet Connector Works with Sitecore

1.3 How the Clay Tablet Connector Works with Sitecore
The Clay Tablet Connector ("Connector") is an important part of the Clay Tablet translation solution.
The Connector is installed on your system as an add-in to the Sitecore CMS. Its functionality is displayed to the
users as part of the Sitecore Content Editor, Page Editor (Sitecore 6 and 7), Experience Editore (Sitecore 8) and
Desktop.

Your translation systems architecture might look like the configuration above. It may have additional CMSs or
translation providers, but the core concepts remain the same. If your translation provider is Lionbridge, it is
accessed via either Freeway or onDemand.
During implementation, Clay Tablet works with you and your translation providers to configure and test the
other elements of your translation solution, which are the Clay Tablet Platform's connections to your
translation providers' systems.

1.4 Using this Guide
Purpose of this guide
This guide describes everything you need to know to install and configure the Clay Tablet Connector
("Connector") for Sitecore. It describes the delivery package contents, system requirements, installation
instructions, and configuration procedures.
Recommendation: Review the user guide to fully understand the powerful features of the Connector.

Who should use this guide
This guide is intended for Sitecore administrators and system integrators.

What you should already know
This document assumes that your company already has an installed instance of Sitecore. It assumes that you
have a strong working knowledge of the Sitecore Content Editor and Sitecore features, specifically how to
configure workflows and associate them with templates.
If Lionbridge is your company's translation provider, it assumes that either Freeway or onDemand is already set
up for your company.

Clay Tablet Connector for Sitecore Installation and Configuration Guide
Version 3.10.2

Page 9
August 16, 2017

1 Welcome to the Clay Tablet Connector for Sitecore

1.5 How to Contact Clay Tablet Support

How to find out more about the Clay Tablet Connector for Sitecore
For information on using the Clay Tablet Connector to send and receive content for translation from Sitecore,
read the Clay Tablet Connector for Sitecore User Guide.

Documentation conventions
This guide uses the following conventions:
Convention

Description

Bold

Highlights screen elements such as buttons, menu items, and fields.

Courier

Highlights input, file names, and paths.

Italics

Highlights terms to emphasize, variables, or document titles.

>

Indicates a menu choice. For example, "Select Sitecore Desktop > All Applications > CTC
Translation > Translation Filter."

1.5 How to Contact Clay Tablet Support
Email @: support@clay-tablet.com
Telephone: +1-416-363-0888
You can submit a support ticket either:
by email
from the Clay Tablet Zendesk page, using your web browser

To submit a support ticket:
1. Do one of the following:
Email support@clay-tablet.com, and cc (carbon copy) anyone to include in the ticket correspondence.
Important: Include the information and attachments in your email that are listed in the sub-sections
below.
Create a ticket in Zendesk:
a. Open the Clay Tablet Zendesk page in your browser: https://claytablet.zendesk.com.
b. Sign in to Zendesk. If you do not have sign-in credentials, see "To view and update your support ticket
in Zendesk:" below.
Important: Include the information and attachments that are listed in the sub-sections below.
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c. Click Submit a request.
d. In the CCs field, add anyone to include in the ticket correspondence.
Zendesk automatically creates a ticket and responds to everyone included in the cc field.
2. Everyone in the original cc receives updates unless they request to be removed from the ticket.
Important: Check your email spam folder (especially first-time Zendesk users) as sometimes email
notifications from Zendesk are marked as spam.
When the issue is resolved, Clay Tablet closes the ticket.

Information to include in the support ticket:
client name
CMS or content system name and version
Connector or App version installed
name of job for which the issue occurs
date of job submission
detailed description of the issue
any error text–copy and paste, if applicable

Files to attach to the support ticket:
CMS log files for the date the issue occurred
Clay Tablet log files for the date the issue occurred
screen capture of the issue

To view and update your support ticket in Zendesk:
Important: You must log into Zendesk to view your support tickets there.
1. Open the Clay Tablet Zendesk page in your browser: https://claytablet.zendesk.com.
2. In the top-right corner, click Sign in, and enter your credentials.
Note: If you do not have sign-in credentials yet, then click either Sign up or Get a password, and follow the
onscreen instructions.
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3. After signing in, click My activities to view the tickets you opened or where you are cc’d.
4. To update tickets, you can reply or attach files.
For more information, refer to "Submitting and tracking support requests" in Zendesk's Help Center guide for
end-users, at: https://support.zendesk.com/hc/en-us/articles/203664386-Help-Center-guide-for-agents-andend-users.
Important: Zendesk refers to a support ticket as a support request. These terms are interchangeable.
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2.1 System Requirements

2 Before You Install
Before you begin to install the Clay Tablet Connector for Sitecore, please review the system requirements,
described below, and perform the following pre-installation procedures:
1. "Setting Your System Date, Time, and Time Zone Correctly" on page 14.
2. "Downloading the Delivery Package" on page 14. This describes the contents of the Connector delivery
package that Clay Tablet Technologies sends you.
3. "Setting Up the Translation Database" on page 16. This section includes information about database size
requirements as well as detailed instructions for Oracle and Microsoft SQL Server databases.
4. "Creating the Connector Folders" on page 20. These are the folders where the Connector stores your
licensing information and your translation data.
5. "Installing the CMS Address Key and the Platform Key" on page 20. These are your license keys.
Very important: Do not copy the CMS address keys to multiple Sitecore instances, because this is a violation
of the Clay Tablet License Agreement. Using the same CMS address keys on multiple Sitecore instances will
cause the Connector to behave unexpectedly, which can result in lost translation content, orphaned
projects, and inaccurate translation status reports. Clay Tablet will support technical issues caused by
duplicating or incorrectly installing CMS address keys only on a time and materials basis.
6. If you are installing the Connector on Sitecore 6.x, you must set the .NET target framework in IIS for
application pool to 4.0. This is necessary because the package has some newer assemblies that cannot target
the earlier target framework.

2.1 System Requirements
The Clay Tablet Connector for Sitecore (Connector) must be installed on the machine where Sitecore is installed.
The Connector supports Sitecore versions 6.4 and higher, including all current releases.
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2.2 Setting Your System Date, Time, and Time Zone Correctly

The Connector has no additional hardware or software requirements beyond those of Sitecore CE. For detailed
requirements, refer to the appropriate version of the Sitecore CMS Installation Guide. This guide is available in
the documentation section of the Sitecore Developer Network (SDN) site, at
http://sdn.sitecore.net/Reference.aspx. You must log in to this site to access the documentation.
Note about Sitecore Azure: The Connector installation is supported for Sitecore installed via the Sitecore Azure
Toolkit 8.2 and higher. The Connector installation on Sitecore installed with the Sitecore Azure Module (Sitecore
8.1 and lower) is not fully supported. For guidance on installing the Connector with the Sitecore Azure Module,
please contact Clay Tablet Support.
The Connector supports the Mozilla Firefox and Google Chrome web browsers. The Connector supports
Microsoft Internet Explorer 11 with Sitecore 7 and 8.

2.2 Setting Your System Date, Time, and Time Zone Correctly
The Clay Tablet Connector sends content to and receives content from the Clay Tablet Platform, which is hosted
in the Amazon Web Services (AWS) environment. AWS requires any machines that connect to its applications to
have the correct system time and date settings.
Important: Before proceeding, ensure that the system date, time, and time zone are set correctly on any
systems that will run the Clay Tablet Connector. If these settings are incorrect, the following error message is
displayed: Error. The difference between the request time and the current time is too
large.

2.3 Downloading the Delivery Package
1. Download the Clay Tablet Connector ("Connector") delivery package from the link that Clay Tablet
Technologies sends you. This is a .rar file, which is a zipped file that contains that contains the following five
folders:
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2.3 Downloading the Delivery Package

Folder Name Description
Accounts

Documents

Sitecore
Package

Two or more keys, which enable the Connector to access the storage and message-queue
services on the Amazon S3 and SQS web services. Each key is in a separate XML file.
source.xml: The Connector uses this CMS address key to move the files your
company exports from Sitecore to the Clay Tablet Platform. The Platform then forwards
your exported files to your translation provider. If you have multiple Sitecore
installations, you must have one key (file) for each environment. If you are using
multiple translation providers, there is one key (file) for each provider.
target.xml: This is your company's platform key, for the Clay Tablet Platform.
Very important: Do not copy the CMS address keys to multiple Sitecore instances,
because this is a violation of the Clay Tablet License Agreement. Using the same CMS
address keys on multiple Sitecore instances will cause the Connector to behave
unexpectedly, which can result in lost translation content, orphaned projects, and
inaccurate translation status reports. Clay Tablet will support technical issues caused by
duplicating or incorrectly installing CMS address keys only on a time and materials basis.
Clay Tablet Connector for Sitecore Installation and Configuration Guide (this
document)
Clay Tablet Connector for Sitecore User Guide
CT3_LanguageCodes.txt: The Connector language codes. Later you will set up these
codes for each Sitecore language your company uses for translation, both source and
target languages. These language codes are also listed in "Appendix: Language Codes"
on page 76.
CT_Sitecore-x.x.xx.zip, where x.x.xx is the current version number of the

Connector for Sitecore. This the installation package that you will install into your Sitecore
Content Editor system.
Note about updating your Connector installation: If you are installing an update to an
installation of the Connector for Sitecore, you install the CT_Sitecore_DLL_Updatex.x.xx.zip package instead. This prevents overwriting your Connector configuration.
Note about installing the Special Edition for Lionbridge Freeway: If you are installing
the Special Edition for Lionbridge Freeway, you install the CT_Sitecore_Lioxx.x.xx.zip package instead.
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Folder Name Description
Workbox

Advanced Workbox is an optional feature, which replaces the standard Sitecore Workbox.
It enables much more powerful management of large lists of items, including by language.
You can sort by different column headings, approve many items at once, and manage the
display of long lists easily.
Important: Install this feature only if you are comfortable with replacing the standard
Sitecore workbox.
This folder contains the following items:
Advanced Workbox installation package
Advanced Workbox Installation Guide

2. Unzip the delivery package file you downloaded, and save its contents to a convenient location.

2.4 Setting Up the Translation Database
You set up the database so that the Connector can use it to store translation-related data.
For instruction on setting up a Microsoft SQL Server database, see page 17.
For instructions on setting up an Oracle database, see page 18.
For instructions on setting up a Microsoft Azure SQL database, see page 18.

2.4.1 Translation Database Size Requirements
The required size of the database depends on the volume of translation you anticipate. When the database is
used only for translation-related data, 100MB is usually adequate. However, by default, the Clay Tablet
Connector backs up translation data, which it uses to support the Translation Correction, Update Remote TM,
and SyncTranslation features. For descriptions of these features, refer to the Clay Tablet Connector for Sitecore
User Guide.
If you keep the default setting of backing up data so that you can use these features, you may need to
increase the size of the database by 50 to 100 percent to support the backup.
If you do not want to back up data, you do not need to increase the size of the database.
Note: To prevent the Connector from backing up translation-related data, you modify the
ClayTablet.BackupTranslationData setting, described in "Configuring Database Settings" on page 19.
You can use the Connector to delete the translation-backup database at any time from the Sitecore Content
Editor, however the relevant Connector features will not work properly. For instructions on deleting the
backup, refer to the Clay Tablet Connector for Sitecore User Guide.
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2.4 Setting Up the Translation Database

2.4.2 Setting Up a Microsoft SQL Server-Based Translation Database
This section describes how to set up a Microsoft SQL Server database to use with the Connector. For
information on database size requirements, see "Setting Up the Translation Database" on page 16.
1. Use Microsoft SQL Server Management Studio to create an empty database. For detailed instructions, refer
to the Microsoft SQL Server documentation.
Recommendation: Name the new database CT3Translation.
2. Configure the Connector database connection string. The Website_root/App_
Config/ConnectionStrings.config file defines the database connections.
Important: The database part of the connection string must match the database name you created in the
previous step.
Typically, it should be:
<?xml version="1.0" encoding="utf-8"?>
<connectionStrings>
<!-Sitecore connection strings.
All database connections for Sitecore are configured here.
-->
<add name="core" connectionString="user id=xxx;password=xxxt;Data
Source=xxx;Database=XXX_Core"/>
<add name="master" connectionString="user id=xxx;password=xxxt;Data
Source=xxxx;Database=XXX_Master"/>
<add name="web" connectionString="user id=xx;password=xxx;Data
Source=xxx;Database=XXX_Web"/>
</connectionStrings>

You must add one more connection string called CT3Translation for the Connector database. This is the
name of the database from above:
<add name="CT3Translation" connectionString="user id=xxx;password=xxx;Data
Source=xxx;Database= CT3Translation "/>

Note: Do not use any name other than CT3Translation for the connection string.
The User ID, password, and Data Source values are usually the same as those used for the other
connection strings.
Note: The user specified in the connection string must have permission to modify the table structure in the
database. This user must have permission to run ALTER TABLE statements.
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2.4.3 Setting Up an Oracle-Based Translation Database
This section describes how to set up an Oracle database to use with the Connector. For information on
database size requirements, see "Setting Up the Translation Database" on page 16.
Recommendation: Create a separate Oracle database user for Clay Tablet data. Alternatively, you can use an
existing Oracle database user for Clay Tablet data.
1. Optional. Create a Oracle database user for Clay Tablet data, using SQL statements similar to the following:
CREATE USER ctttrans IDENTIFIED BY xxxxxxxx
DEFAULT TABLESPACE users TEMPORARY TABLESPACE temp;
GRANT UNLIMITED TABLESPACE TO ctttrans;
GRANT CONNECT, CREATE TABLE TO ctttrans;

2. Add a CT3Translation.Oracle connection to the Sitecore connection string configuration. Add the
following to the Sitecore connection string configuration:
<add name="CT3Translation.Oracle" connectionString="user
id=ctttrans;password=xxxxxxxx;Data Source=XE"/>

Depending on the active configuration in the user's setup, this is one of the following:
Website/App_Config/ConnectionStrings.config
Website/App_Config/ConnectionStringsOracle.config

Note: The user specified in the connection string must have permission to modify the table structure in the
database. This user must have permission to run ALTER TABLE statements.
3. Ensure that the right version of Oracle.DataAccess.dll is in the Website/bin directory or in the right
path. The DLL should match the Oracle database that the user is using. If the user is already using Oracle as
the database for the Sitecore content, this should already be set up correctly.

2.4.4 Setting Up a Microsoft Azure SQL-Based Translation Database
This section describes how to set up a Microsoft Azure SQL database to use with the Connector. For information
on database size requirements, see "Setting Up the Translation Database" on page 16.
1. Create an empty Azure database. For detailed instructions, refer to the Microsoft Azure documentation.
Recommendation: Name the new database CT3Translation.
2. Configure the Connector database connection string. The Website_root/App_
Config/ConnectionStrings.config file defines the database connections.
Important: The database part of the connection string must match the database name you created in the
previous step.
Typically, it should be:
<?xml version="1.0" encoding="utf-8"?>
<connectionStrings>
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<!-Sitecore connection strings.
All database connections for Sitecore are configured here.
-->
<add name="core" connectionString="user id=xxx;password=xxxt;Data
Source=xxx;Database=XXX_Core"/>
<add name="master" connectionString="user id=xxx;password=xxxt;Data
Source=xxxx;Database=XXX_Master"/>
<add name="web" connectionString="user id=xx;password=xxx;Data
Source=xxx;Database=XXX_Web"/>
</connectionStrings>

You must add one more connection string called CT3Translation for the Connector database. This is the
name of the database from above:
<add name="CT3Translation" connectionString="Data
Source=tcp:SERVER.database.windows.net;Initial Catalog=DB_NAME;Integrated
Security=False;User ID=USER_NAME@SERVER;Password=PASSWORD;Encrypt=True"/>

For example:
<add name="CT3Translation" connectionString="Data
Source=tcp:mpr0fb9mzh.database.windows.net;Initial Catalog=CTT;Integrated
Security=False;User ID=CTT@mpr0fb9mzh;Password=csct@blet99;Encrypt=True"/>

Note: Do not use any name other than CT3Translation for the connection string.
The User ID, Password, and Data Source values are usually the same as those used for the other
connection strings.
Note: The user specified in the connection string must have permission to modify the table structure in the
database. This user must have permission to run ALTER TABLE statements.

2.4.5 Configuring Database Settings
You configure the Connector's database settings by modifying the following configuration file: Website_
root/Website/App_Config/Include/CT3Translation.config. You can specify the following settings:
Setting Name

Description

Supported
Values

Default
Value

ClayTablet.
Translation
Database

The location of your Sitecore content. If your Sitecore content is
not in the master database, then you must change this value to
match the name of your content database.

a
database
name

master

Clay Tablet Connector for Sitecore Installation and Configuration Guide
Version 3.10.2

Page 19
August 16, 2017

2 Before You Install

2.5 Creating the Connector Folders

Setting Name

Description

ClayTablet.
Backup
TranslationData

Determines whether or not the Connector stores backup
translation data on the Content Editor server to support the
Translation Correction, Update Remote TM, and SyncTranslation
features. For descriptions of these features, refer to the Clay Tablet
Connector for Sitecore User Guide. If you do not want to use these
features, you can change this setting to False. This prevents
substantial amounts of data from being stored on your Sitecore
server, but it also prevents your company from accessing these
useful features.
Recommendation: Initially keep the default setting of True in case
you want to use any of the features that rely on this data.

Supported
Values
True
False

Default
Value
True

2.5 Creating the Connector Folders
This section describes how to create folders that the Connector uses to store licensing information and
translation data.
1. Under the Sitecore data folder, create the CT3 folder.
Important: Ensure that you create the CT3 folder under the Sitecore data folder, and not under the Sitecore
website root folder. To locate the Sitecore data folder, check the Web.config file, searching for a line such
as:
<sc.variable name="dataFolder" value="C:\Inetpub\wwwroot\Sitecore6\Data\"/>.
For the location in this example, you would create the CT3 folder as:
"C:\Inetpub\wwwroot\Sitecore6\Data\CT3".
2. Create two sub-folders under the CT3 folder you just created:
Accounts. Set folder security so that the Windows account used by IIS has read permission.
Data. Set folder security so that the Windows account used by IIS has full permission.

2.6 Installing the CMS Address Key and the Platform Key
Very important: Do not copy the CMS address keys to multiple Sitecore instances, because this is a violation of
the Clay Tablet License Agreement. Using the same CMS address keys on multiple Sitecore instances will cause
the Connector to behave unexpectedly, which can result in lost translation content, orphaned projects, and
inaccurate translation status reports. Clay Tablet will support technical issues caused by duplicating or
incorrectly installing CMS address keys only on a time and materials basis.

Clay Tablet Connector for Sitecore Installation and Configuration Guide
Version 3.10.2

Page 20
August 16, 2017

2 Before You Install

2.6 Installing the CMS Address Key and the Platform Key

The Connector uses the CMS address key, which is in source.xml, to move the files your company exports
from Sitecore to the Clay Tablet Platform. The Platform then forwards your exported files to your translation
provider. If you have multiple Sitecore installations, there must be one key (file) for each environment. If you
are using multiple translation providers, there must be one key (file) for each provider.
Note: The Connector always initiates calls to the Clay Tablet Platform. However, the CMS address keys
enable establishing a secure, discrete connection between the Connector instance and the Platform. They
also support the return of files from translation.
Your company's platform key is in target.xml. This is your company's license for the Clay Tablet Platform.
Important: If you do not install this key, the Connector will run. However, an Upgrade button will be
displayed in the CTC Translation tab in the Sitecore Content Editor ribbon, and many user interfaces will
display errors.

To install the CMS address key and the platform key:
Copy the file with the CMS address key (source.xml) and the file with the platform key (target.xml) from
the <Delivery Package/Accounts> folder to the CT3/Accounts folder. This installs the license for one
Sitecore instance and one translation provider.
Note: For instructions on installing CMS address keys for additional service providers, see "Configuring the
Connector to Work with Multiple Translation Providers" on page 27.
Now you are ready to install the Connector, as described in "Installing the Clay Tablet Connector for Sitecore"
on page 22.

Clay Tablet Connector for Sitecore Installation and Configuration Guide
Version 3.10.2

Page 21
August 16, 2017

3 Installing the Clay Tablet Connector for Sitecore

3 Installing the Clay Tablet Connector for Sitecore
This section describes how to install the Connector installation package you downloaded earlier into your
Sitecore system.
Before you install the Clay Tablet Connector ("Connector"), verify that you have reviewed the system
requirements and followed all the pre-installation procedures described in "Before You Install" on page 13.

To install the Connector into Sitecore (Sitecore 6 and 7):
1. On the Sitecore Desktop, on the Sitecore Start menu, select Sitecore > Development Tools > Installation
Wizard.
The Welcome page of the Sitecore Install Package wizard opens.
2. Click Next.
The Select Package page of the Sitecore Install Package wizard opens.
3. Click Browse, and locate the installation package that you downloaded earlier. For details, see "Downloading
the Delivery Package" on page 14.
Tip: The installation package is in the following location in the delivery package: <Delivery
Package/Sitecore Package/>.
4. Click Upload to upload the package.
5. After the package is uploaded, click Next.
6. Follow any on-screen instructions to finish installing the Connector package into Sitecore.
Next you configure Connector parameters, as described in "Configuring the Clay Tablet Connector for Sitecore"
on page 25.

To install the Connector into Sitecore (Sitecore 8):
1. On the Sitecore Desktop, on the Sitecore Start menu, select Sitecore > Development Tools > Installation
Wizard.
The Install a Package wizard opens.
2. Click Upload package.
The Upload Files wizard opens.
3. Click Browse, and locate the installation package that you downloaded earlier. For details, see "Downloading
the Delivery Package" on page 14.
Tip: The installation package is in the following location in the delivery package: <Delivery
Package/Sitecore Package/>.
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4. In the wizard, click Next.
5. In the next page of the wizard, select the Overwrite existing files check box, and then click Upload.
6. After the file uploads, click Close.
7. In the Install a Package wizard, click Choose package.
The Choose Package dialog box opens.
8. Select the package you uploaded, so that its name is displayed in the File name field, and click Open.
In the Install a Package wizard, the Name field displays the name of the package you selected.
9. Click Next.
10. Follow any on-screen instructions to finish installing the Connector package into Sitecore.
Next you configure Connector parameters, as described in "Configuring the Clay Tablet Connector for Sitecore"
on page 25.

3.1 Installing a Language Package for the Connector
By default the Connector user interface is displayed in English. However, you can install a language package to
display the Connector user interface in another supported language.
This section describes how to install a language package for the Connector that you downloaded earlier into
your Sitecore system. This language package displays the Connector user interface in the supported language.
Note: You can use any language version of the Sitecore user interface to install the Connector language
package.
Currently, a language package is available for Japanese. To obtain a language package, please contact Clay
Tablet Support, as described in "How to Contact Clay Tablet Support" on page 10.

To install a Connector language package into Sitecore (Sitecore 6 and 7):
1. On the Sitecore Desktop, on the Sitecore Start menu, select Sitecore > Development Tools > Installation
Wizard.
The Welcome page of the Sitecore Install Package wizard opens.
2. Click Next.
The Select Package page of the Sitecore Install Package wizard opens.
3. Click Browse, and locate the language package that you received from Clay Tablet. This package has the
following format: CT_Sitecore_Language_Pack-language-code-x.x.xx.zip, where x.x.xx is the
current version number of the Connector for Sitecore, and language-code is the language code of the
language package, for example: CT_Sitecore_Language_Pack-ja-JP-3.10.0.zip. For details, see
"Downloading the Delivery Package" on page 14.
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4. Click Upload to upload the package.
5. After the package is uploaded, click Next.
6. Follow any on-screen instructions to finish installing the Connector language package into Sitecore.

To install the Connector language package into Sitecore (Sitecore 8):
1. On the Sitecore Desktop, on the Sitecore Start menu, select Sitecore > Development Tools > Installation
Wizard.
The Install a Package wizard opens.
2. Click Upload package.
The Upload Files wizard opens.
3. Click Browse, and locate the language package that you received from Clay Tablet. This package has the
following format: CT_Sitecore_Language_Pack-language-code-x.x.xx.zip, where x.x.xx is the
current version number of the Connector for Sitecore, and language-code is the language code of the
language package, for example: CT_Sitecore_Language_Pack-ja-JP-3.10.0.zip. For details, see
"Downloading the Delivery Package" on page 14.
4. In the wizard, click Next.
5. In the next page of the wizard, select the Overwrite existing files check box, and then click Upload.
6. After the file uploads, click Close.
7. In the Install a Package wizard, click Choose package.
The Choose Package dialog box opens.
8. Select the package you uploaded, so that its name is displayed in the File name field, and click Open.
In the Install a Package wizard, the Name field displays the name of the package you selected.
9. Click Next.
10. Follow any on-screen instructions to finish installing the language package into Sitecore.
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4 Configuring the Clay Tablet Connector for Sitecore
You perform the following steps to configure your Connector installation:
1. "Configuring the Connector for the Clay Tablet On-Premise Platform" on page 25. Required only if you are
using the Clay Tablet On-Premise Platform ("Platform"), which is the Clay Tablet Platform that you host and
manage, in contrast to the Clay Tablet Platform that is hosted on AWS by Clay Tablet.
2. "Configuring the Connector to Run in a Clustered Environment of Multiple Load-Balanced Sitecore Servers"
on page 26. Required only if you are using the Connector in a clustered environment of multiple loadbalanced Sitecore servers.
3. "Configuring Network Settings for a Firewall" on page 26. Optional.
4. "Configuring the Connector to Work with Multiple Translation Providers" on page 27. Required only if you
will be sending content for translation to multiple translation providers.
5. "Configuring Global Translation Settings" on page 28.
6. "Configuring Global Service Settings" on page 47. Optional.
7. "Configuring the Sitecore Languages in the Sitecore Content Editor" on page 49.
8. "Configuring the Translation Workflow" on page 50.
9. "Filtering Fields in Items that Do Not Need Translation" on page 59.
10. "Configuring Connector Roles and Adding Users" on page 66.
11. "Configuring the In-Context Preview Feature" on page 67.
Important: This feature is currently in alpha testing. It is not currently generally available for production
usage.
12. "Configuring Freeway and Login Credentials" on page 67. Relevant only if you are using the Special Edition
for Lionbridge Freeway.

4.1 Configuring the Connector for the Clay Tablet On-Premise Platform
If you are using the Clay Tablet On-Premise Platform ("Platform"), which is the Clay Tablet Platform that you
host on your premises, you configure your Connector to point to this platform.

To configure the Connector to point to your Clay Tablet On-Premise Platform:
1. Open the Website_root/Website/App_Config/Include/
CT3Translation.config file for editing.
2. Uncomment the following setting:
<!-- Uncomment this to configure URL to CTWS backend for On-Premise platform
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<setting name="ClayTablet.CTWS.URL" value="http://ctws.ctt-platform-int.com/"/>
-->

3. Modify the ClayTablet.CTWS.URL setting to the DNS, IP address, or host name of the where your CTWS
service is running on IIS.
Note: The address must include the protocol, such as http:// or https://, for example, http://claytablet.com.
4. Save your changes.

4.2 Configuring the Connector to Run in a Clustered Environment of Multiple LoadBalanced Sitecore Servers
In a clustered environment of multiple load-balanced Sitecore servers, all servers can provide the Connector's
user-interface features. However, only one server can send and receive translation jobs. This server is the
primary server. You use the ClayTablet.Sitecore.PrimaryServer setting to specify which Sitecore server
is the primary server.
In a single-server environment with one Sitecore server, this setting is not relevant, so it is commented out
by default.
In a clustered environment, you must configure the Connector on each Sitecore server to point to the
primary server. This ensures that only the primary server can send or receive translations.

To configure the Connector on each Sitecore server in a clustered environment:
1. Open the Website_root/Website/App_Config/Include/
CT3Translation.config file for editing.
2. Locate the ClayTablet.Sitecore.PrimaryServer setting, and uncomment it.
3. Change the value of this setting to either the host name or the IP address of the primary server.
Important: Enter the same value on each Sitecore server in your clustered environment.
4. Save your changes.
Important: Repeat these steps on each Sitecore server in your clustered environment.
Note: To change the primary server, update this value on the current primary server before updating it on all
the other servers.

4.3 Configuring Network Settings for a Firewall
Optional step. If you have a firewall, you must configure your ports so that the Connector can communicate
with the Clay Tablet Platform. The Connector must be able to communicate with the Clay Tablet Platform by
initiating the following outbound network connections:
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Protocol

Port
Number

HTTP

4.4 Configuring the Connector to Work with Multiple Translation Providers

Description

Location

Port 80

For access to Amazon's AWS S3 XML namespace
and XSD file

http://s3.amazonaws.com

HTTP

Port 80

For access to Amazon's AWS SQS XML
namespace and XSD file

http://queue.amazonaws.com

HTTPS

Port 443

For secure access to Amazon's AWS S3 service

https://s3.amazonaws.com

HTTPS

Port 443

For secure access to Amazon's AWS SQS service

https://queue.amazonaws.com

4.4 Configuring the Connector to Work with Multiple Translation Providers
This section is required only if your Connector will work with multiple translation providers. You can configure
the Connector to work with multiple translation providers, so that you can send content to multiple translation
vendors directly from Sitecore.
This section assumes that you have already installed the CMS address key (in source.xml) for your first
(default) translation provider in step 4 of "Installing the Clay Tablet Connector for Sitecore" on page 22. The
Connector requires a separate source.xml file for each translation provider, because the CMS address key is
unique for each translation provider. The Connector uses this key to move your files from your Sitecore
installation to the Clay Tablet Platform, and then to your translation provider.
Note: You use the same platform key (target.xml) for all your Sitecore installations and translation providers.

Note: If your translation provider is Lionbridge, then either Freeway or onDemand is Translation Provider
1 in the diagram above.
The instructions below describe how to install the CMS address key for your second translation provider:
1. Rename the file with the CMS address key for your second translation provider to source2.xml. This will
prevent overwriting the CMS address key that you previously installed.
2. Copy the file with the CMS address key for your second translation provider to the following directory:
data/CT3/Accounts on the Sitecore server.
3. Edit Website/App_Config/Include/CT3Translation.config. so that it is similar to the following:
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The default translation provider is configured with ClayTablet.Account (the name of the translation
provider), ClayTablet.SourceAccount (CMS address key), and ClayTablet.TargetAccount (account
license key):
<setting name="ClayTablet.Account" value="Translation Provider Name"/>
<setting name="ClayTablet.SourceAccount"
value="$(dataFolder/CT3/Accounts/source.xml"/>
<setting name="ClayTablet.TargetAccount"
value="$(dataFolder/CT3/Accounts/target.xml"/>

The second translation provider is configured with ClayTablet.Account2 (the name of the translation
provider) and ClayTablet.SourceAccount2 (CMS address key):
<setting name="ClayTablet.Account2" value="Translation Provider 2 Name"/>
<setting name="ClayTablet.SourceAccount2" value="$(dataFolder)
/CT3/Accounts/source2.xml"/>

The value of ClayTablet.TargetAccount2 (account license key) is generally the same for all translation
providers.
Note: If this value is the same as ClayTablet.TargetAccount, you do not have to modify it.
<setting name="ClayTablet.TargetAccount2" value="$(dataFolder)
/CT3/Accounts/target.xml"/>

Repeat these steps for each additional translation provider that you work with.
Important: Ensure that the files with the CMS address keys have unique names so that they do not overwrite
the CMS address keys for other translation providers.

4.5 Configuring Global Translation Settings
The Connector's global translation settings determine how the Connector sends out all translation jobs. These
translation settings are in the following locations:
the following configuration file: Website_root/Website/App_
Config/Include/CT3Translation.config
configuration settings in the Content Editor in: /sitecore/System/Settings/Clay Tablet Settings
You can perform the following configuration steps:
"Configuring Bulk Translation Settings" on page 29
"Configuring Email-Notification Settings" on page 33
"Configuring Logging Settings" on page 37
"Configuring Platform Settings" on page 37
"Enabling the Request Quote Feature" on page 38
"Configuring Target Translation Data Settings" on page 40
"Configuring Translation Settings" on page 41
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"Configuring Update-TM Settings" on page 45
"Configuring Job-Metadata Settings" on page 46
"Configuring SEO-Field Settings" on page 38

4.5.1 Configuring Bulk Translation Settings
There are multiple places to configure settings for the Bulk Translation wizard:
Setting
the default value of the Sync Translation check
box in the Advanced Translation Options
section of the Translation Options page in the
wizard
which target languages to display in the Settings
page
the default value of the Send Dependent Items
check box in the Choose Items page of the
wizard

Where to Configure

For Details, See...

the Sitecore user interface

"Configuring Bulk
Translation Settings in
Sitecore" on page 31

the Website_root/
Website/App_Config/
Include/
CT3Translation.config
configuration file

"Configuring Bulk
Translation Settings in
the Configuration File"
on page 29

whether to collect Sitecore items in specific
templates, including item buckets, to send out
for translation
all other settings

Note: You can also create an extension to modify the behavior of the Send Dependent Items check in the
Choose Items page of the wizard. For details, see "Configuring the Behavior of the Send Dependent Items check
box" on page 85.

4.5.1.1 Configuring Bulk Translation Settings in the Configuration File
You can specify the following settings in the Website_root/Website/App_
Config/Include/CT3Translation.config configuration file:
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Setting Name

Description

ClayTablet.Bulk
Translation
RootID

This sets the /Sitecore/content directory (ID:
{0DE95AE4-41AB-4D01-9EB0-67441B7C2450}) as the default
root from which the Connector collects items for
translation for the Bulk Translation feature. This feature
collects large batches of content from the site tree for bulk
export. If you want content from only one site to be
translated, then you must change the value of this item's
ID to that path. For example if you want to translate items
only from Sitecore/Content/home/site1/, then you
must change the value of this item's ID to
Sitecore/Content/home/site1/.

Supported
Values

Default Value

either the
default ID
or a path

{0DE95AE441AB-4D019EB067441B7C2450}

100

Note: There can be only one root directory.
ClayTablet.
Maximum
ItemsInOne
TranslationFile

This setting determines the maximum number of Sitecore
items to pack into a single file for translation. You can
adjust the number to better suit your translation
requirements.
Recommendation: Discuss this with your translation
provider.

an integer

ClayTablet.
PreventSenting
ItemsWithout
Workflow

When using the Bulk Translation wizard, determines
whether or not the Connector sends out items for
translation that are not assigned to a workflow.
If you set this value to True, then when using the Bulk
Translation wizard to send out content for translation,
the Connector does not send out items not assigned to
a workflow.
If you set this value to False, then using the Bulk
Translation wizard sends out all selected items for
translation, even if they are not assigned to a workflow.

True
False

True for
new
Connector
installations
False for
upgraded
Connector
installations

Warning: This creates a target version with source
language content, which becomes publishable
immediately.
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Setting Name

Description

ClayTablet.State
ToAssignInBulk
Translation

Determine the default state displayed in Workflow
Option: applied to all items selected > With state
dropdown list in the Translation Options page of the Bulk
Translation Wizard. This is the default state to assign to
source items without workflow state when sending them
out for translation from the wizard. The default value
points to the Review state in CT3SampleWorkflow, but
you can change this to another state in that workflow or
another workflow.

Supported
Values
a
workflow
state

Default Value
4B7E2DA9DE43-4C8388C302F042031D04

4.5.1.2 Configuring Bulk Translation Settings in Sitecore
You can specify some settings for the Bulk Translation wizard in the Sitecore user interface.

To configure settings for the Bulk Translation wizard:
1. In the Content Editor, in the content tree, navigate to the /sitecore/system/Settings/Clay Tablet
Settings folder.
Tip: Scroll down to the bottom of the Settings folder to locate the Clay Tablet Settings sub-folder.
2. Click the Clay Tablet Settings item in the folder to open it in the Content Editor.
3. Scroll down to the Bulk Translation section.
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4. Specify one or more of the following options:
Option

Description

Use Local TM
Only send
fields with
changed
content

Select or clear this check box to specify the default value of the Use Local TM check box in
the Advanced Translation Options section of the Translation Options page in the wizard.
For a detailed explanation of this option, refer to "Sending Multiple Content Items for
Translation" in the Clay Tablet Connector for Sitecore User Guide.

Default
Target
Languages

In this section, you can select which target languages to select by default in the Settings
page of the wizard by selecting the corresponding check boxes. If you do not select any
target languages, then all the check boxes for the target languages are blank.

Send
dependent
items

Select or clear this check box to specify the default value of the Send Dependent Items
check box in the Choose Items page of the wizard.
Note: This also specifies the default value of the Send Dependent Items check box in the
Automatic Item Export for Translation dialog box.
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Option

Description

Templates
Excluded
from Bulk
Translation

Use the arrows to move items to exclude to the Selected list. This instructs the wizard to
exclude Sitecore items with the corresponding templates when it collects items for
translation. By default, Bucket and Folder are selected, so that the wizard excludes item
buckets and folders from items that it collects to send out for translation.

4.5.2 Configuring Email-Notification Settings
There are multiple places to configure email-notification settings:
For Details,
See...

Setting

Where to Configure

The default amount of time, in hours, that a job is stuck,
and it fails to reach 10% (In Translation) status. After
this interval, the Connector automatically sends an email
notification that the job is stuck.

the Sitecore user interface

"Configuring
Email
Notifications in
Sitecore" on page
36

all other settings

the Website_root/
Website/App_Config/
Include/
CT3Translation.config
configuration file

"Configuring
Email
Notifications in
the Configuration
File" on page 33

4.5.2.1 Configuring Email Notifications in the Configuration File
You can specify the following settings in the Website_root/Website/App_
Config/Include/CT3Translation.config configuration file:
Setting Name

Description

ClayTablet.
EmailNotification.
SendEmail

Determines whether or not the Connector sends email
notifications when it sends items out for translation or
it receives translated items back from translation.
To receive email notifications, keep this setting as
True.
To prevent receiving email notifications, change this
setting to False.
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Supported
Values

Default Value

integer

4

Setting Name

Description

ClayTablet.
EmailNotification.
WaitMinutes

The Connector does not send a separate email
notification for each item sent for translation. This
setting determines the interval, in minutes, that the
Connector waits to send one notification email. That
email contains information about all the items that
were sent for translation since the previous
notification.

ClayTablet.
EmailNotification.
SmtpService

Determines which SMTP service the Connector uses to
send notification emails:
LocalSmtp: The Connector uses the SMTP service
on a local server to send emails.
Gmail: If your local server does not have an SMTP
service, the Connector uses the free Gmail SMTP
service to send emails.

ClayTablet.
LOCAL.SMTP.
Server

The IP address of the local SMTP service that sends
notification emails. Relevant only if the value of the
ClayTablet.EmailNotification.SmtpService
setting, described above, is LocalSmtp.

an
IP address

127.0.0.1

ClayTablet.
LOCAL.SMTP.
Port

The port number of the local SMTP service that sends
notification emails. Relevant only if the value of the
ClayTablet.EmailNotification.
SmtpService setting, described above, is
LocalSmtp.

a port
number

25

ClayTablet.
LOCAL.SMTP.
EnableSSL

Determines whether the SMTP server uses SSL.

ClayTablet.
LOCAL.SMTP.
FromAddress

The "From" email address that the local SMTP service
uses to send notification emails. Relevant only if the
value of the ClayTablet.EmailNotification.
SmtpService setting, described above, is
LocalSmtp.
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Supported
Values

Default Value

The username for authentication for the SMTP server,
if required.
Note: To use SMTP authentication, uncomment this
section.

username

blank

ClayTablet.
LOCAL.SMTP.
Password

The password for authentication for the SMTP server,
if required.
Note: To use SMTP authentication, uncomment this
section.

password

blank

ClayTablet.
EmailNotification.
NotifySentOut

Determines whether or not the Connector sends email
notifications when it sends items out for translation.
To receive email notifications, keep this setting as
True.
Note: You must also set the ClayTablet.
EmailNotification.SendEmail setting,
described above, to True.
To prevent receiving email notifications, change this
setting to False.

True
False

True

ClayTablet.
EmailNotification.
NotifySentOut.
Users.RoleName

The Connector sends email notifications when it sends
items out for translation to all users that have been
added to this role.
This role is installed by default. You must add users to
this role, or change the role name and this setting to
fit your requirements. For information about roles,
see "Configuring Connector Roles and Adding Users"
on page 66.

a role name

ClayTablet.
EmailNotification.
NotifyCompleted

Determines whether or not the Connector sends email
notifications when it receives translated items back
from translation.
To receive email notifications, keep this setting as
True.
Note: You must also set the
ClayTablet.EmailNotification.
SendEmail setting, described above, to True.
To prevent receiving email notifications, change this
setting to False.

True
False

Setting Name

Description

ClayTablet.
LOCAL.SMTP.
User
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Setting Name

Description

ClayTablet.
EmailNotification.
NotifyCompleted.
Users.RoleName

The Connector sends email notifications when it
receives translated items back from translation to all
users that have been added to this role.
This role is installed by default. You must add users to
this role, or change the role name and this setting to
fit your requirements. For information about roles,
see "Configuring Connector Roles and Adding Users"
on page 66.

ClayTablet.
EmailNotification.
NotifyErrors

Determines whether or not the Connector sends
notification emails when an error occurs related to a
translation job.

ClayTablet.
EmailNotification.
NotifyErrors.
Users.RoleName

Sitecore users assigned to this role will receive
notification emails. You can change the role name to
fit your business, or you can add users to this default
role.

4.5 Configuring Global Translation Settings

Supported
Values
a role name

True
False

Default Value
sitecore\
Translation
ItemCompleted
Notification
Receiver

True

Translation
Administrator
(installed by
the Connector)

4.5.2.2 Configuring Email Notifications in Sitecore
You can specify an email-notification setting in the Sitecore user interface.

To configure an email-notification setting:
1. In the Content Editor, in the content tree, navigate to the /sitecore/system/Settings/Clay Tablet
Settings folder.
Tip: Scroll down to the bottom of the Settings folder to locate the Clay Tablet Settings sub-folder.
2. Click the Clay Tablet Settings item in the folder to open it in the Content Editor.
3. Scroll down to the Notification section.

4. Specify the following option:
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Option

Description

Delay
Threshold
Hours

Enter the number of hours after which sending out a translation job is considered "stuck." If
a job is still not at 10% (In Translation) status after this interval, the Connector sends out
an email notification.

4.5.3 Configuring Logging Settings
You configure the Connector's logging settings by modifying the following configuration file: Website_
root/Website/App_Config/Include/CT3Translation.config. You can specify the following settings:
Setting
Name

Description

Supported
Values

Default
Value

ClayTablet.
LogFolder

By default, the Connector logs are in the same folder as the
Sitecore logs. This enables you to use the Sitecore Log Viewer tool
to view Connector logs as well. Connector log files use the
following file-name format: log.CTTLOG.yyyymmdd.txt.

a path

$(dataFolder
/Logs/

ClayTablet.
LogLevel

The minimum logging level written to the log files.

From the
highest to
lowest log
level:
ERROR
INFO
DEBUG
Diagnose

INFO

4.5.4 Configuring Platform Settings
You configure the Connector's setting for the Clay Tablet Platform by modifying the following configuration file:
Website_root/Website/App_Config/Include/CT3Translation.config. You can specify the
following setting:
Setting
Name

Description

ClayTablet.
HeartBeat
Interval
InMinutes

Determines how frequently, in minutes, the Connector sends a
heartbeat message to the Clay Tablet Platform that enables the
Platform to monitor the health of the Connector. To disable the
heartbeat, set this to zero (0).
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4.5.5 Enabling the Request Quote Feature
Important: The Request Quote feature is available only when sending content for translation to a translation
provider (LSP) that supports this feature.
When enabled, this feature displays the Send for Quote check box in:
the Bulk Translation wizard
the Automatic Item export for translation dialog box
the Send Items Out for Translation dialog box, which opens from Translation Queue
Selecting this check box informs the translation provider that you want to receive a quote before the translation
process starts.
You enable this feature in the Website_root/Website/App_Config/Include/CT3Translation.config
configuration file for a particular translation provider.

To enable this feature:
To enable this feature for your primary translation provider (defined by <setting
name="ClayTablet.Account" value="LSP" />), create the following entry in the configuration file:
<setting name="ClayTablet.AccountSupportQuoting" value="True" />.
To enable this feature for your secondary translation provider (defined by <setting
name="ClayTablet.Account2" value="LSP" />), create the following entry in the configuration file:
<setting name="ClayTablet.Account2SupportQuoting" value="True" />.
Note: If this setting is set to False or if it is not specified in the file, then the Send for Quote check box is not
displayed.

4.5.6 Configuring SEO-Field Settings
Your Sitecore items may contain fields specially designed for search engine optimization (SEO), which require
special treatment in translation. You can specify which fields are considered SEO fields, so that you can send out
those fields separately for translation. You can limit these fields to specific templates, or you can specify fields
that are relevant to all templates. You can also specify how the fields are identified in the XML translation files
that the Connector sends to your translation provider, to facilitate proper handling by the translators.
When sending out content for translation, the user can indicate whether to include only SEO fields, or only
standard fields, or both. For detailed instructions, refer to the Clay Tablet Connector for Sitecore User Guide.

To configure SEO-field settings:
1. In the Content Editor, in the content tree, navigate to the /sitecore/system/Settings/Clay Tablet
Settings folder.
Tip: Scroll down to the bottom of the Settings folder to locate the Clay Tablet Settings sub-folder.
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2. Click the Clay Tablet Settings item in the folder to open it in the Content Editor.
3. Scroll down to the SEO Fields section.

4. Specify the following options:
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Option

Description

SEO Flag

Optional. You can specify a custom value for the SEO_Flag attribute, which identifies SEO
fields for translation. By default, the Connector specifies the SEO value for the SEO_Flag
attribute tag in any standard fields you specify as SEO fields, in the SEO Fields section and/or
SEO Field Names field, described below. The SEO_Flag attribute is displayed in the XML files
that the Connector sends to your translation provider.
For example, a standard field is displayed as:
<FieldContent FieldName="Title">...</FieldContent>

For example, an SEO field is displayed as:
<FieldContent FieldName="Title" SEO_Flag="SEO">...</FieldContent>

This setting changes the value of the SEO_Flag attribute for the SEO fields. For example, if
you configure this as Metadata, then your SEO field is displayed as:
<FieldContent FieldName="Title" SEO_Flag="Metadata">...</FieldContent>

This may be useful if your translation provider is looking for a particular attribute value to
identify SEO fields or other metadata for translation.
Note: If you modify the value in this field so that it is blank, you configure the value for the
SEO_Flag attribute to be empty. In this scenario, the Connector does not add the SEO_Flag
attribute to SEO fields, and they are displayed exactly like standard fields.
SEO
Fields

Use the arrows to move fields in a specific template to the Selected list. This marks those fields
as SEO fields for translation. These fields are identified in the XML translation files with the
SEO_Flag attribute, which has a default value of SEO. However you can specify a custom
value for this attribute in the SEO Flag field, as described above.

SEO Field
Names

Enter the comma-separated (,) names of fields to mark as SEO fields for translation. The
Connector marks these fields as SEO fields for translation in all templates.These fields are
identified in the XML translation files with the SEO_Flag attribute, which has a default value
of SEO. However you can specify a custom value for this attribute in the SEO Flag field, as
described above.

4.5.7 Configuring Target Translation Data Settings
You configure the Connector's settings for target translation data by modifying the following configuration file:
Website_root/Website/App_Config/Include/CT3Translation.config. You can specify the
following settings:
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Supported
Values

Default
Value

Setting Name

Description

ClayTablet.
OnlyKeep
TranslationData
FromLatest
Version

Determines whether the Connector keeps translation data only
for the latest version of a content item.
To keep translation data only for the latest version of a
content item, keep this setting as True.
To keep translation data for all versions of a content item,
change this setting to False.

True
False

True

ClayTablet.
TargetTranslation
KeepAllData

When the Connector sends out content for translation, this
setting determines which field values it copies to the target
location.
To copy the field values from the previous version (if it exists)
of the target items to the target location, change this setting
to True.
To copy the field values from source items to the target
location, keep this setting as False.
Note: You specify the setting for copying the values of nontranslatable fields separately, in the
TargetTranslationKeepNotTranslatableData setting,
as described below.

True
False

False

ClayTablet.
TargetTranslation
KeepNot
TranslatableData

When the setting of TargetTranslationKeepAllData,
described above is False, then when the Connector sends out
content for translation, this setting determines which values of
non-translatable fields it copies to the target location.
To copy the values of non-translatable fields from the previous
version (if it exists) of the target items to the target location,
change this setting to True.
To copy the values of non-translatable fields from source items
to the target location, keep this setting as False.

True
False

False

4.5.8 Configuring Translation Settings
There are multiple places to configure translation settings:
Setting

Where to Configure

For Details, See...

which standard fields to
copy to target items

the Sitecore user interface

"Configuring Translation Settings in Sitecore"
on page 44
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Setting

Where to Configure

For Details, See...

all other settings

the Website_root/
Website/App_Config/
Include/
CT3Translation.config
configuration file

"Configuring Translation Settings in the
Configuration File" on page 42

4.5.8.1 Configuring Translation Settings in the Configuration File
You configure the Connector's translation settings by modifying the following configuration file: Website_
root/Website/App_Config/Include/CT3Translation.config. You can specify the following settings:
Supported
Values

Setting Name

Description

ClayTablet.
ProjectIdentifier

This creates the prefix for identifying the client in
translation projects. For example, if the "ABC"
client sets this to ABC and sends out the
marketing_post_Aug08 item for translation, the
name of the translation project is ABC_
marketing_post_Aug08.
Note: Relevant only when using either the Special
Edition for Lionbridge Freeway or the Special
Edition for Lionbridge onDemand.

a text
string

ClientName

ClayTablet.
PackedFile
Format

The Connector can export Sitecore content (field
content) in two different formats: XML and HTML.
XML is the default format, which is acceptable to
most translation providers. If your translation
provider has difficulties handling XML files and can
handle only HTML files, then you can change this
setting to HTML.

either
XML or
HTML

XML

ClayTablet.
Translate
Common
FolderItem

Determines whether or not the Connector sends
out for translation content items that are based on
a common-folder template, located in:
Templates/Common/Folder. This determines
whether the Connector sends out the folder's
fields, including the folder name, for translation.
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Setting Name

Description

ClayTablet.
PreviewURL

Determines whether or not to include a preview
URL in the XML file, which enables translators and
reviewers to preview the content. You can include
the following parameters in the preview:
{id}: Sitecore item ID of the translated item.
{version}: The source version of the
translated item.
{lang}: The source language of the translated
item.
{targetversion}: The target version created
as result of the translation.
{targetlang}: The target language for the
translation.
{jobid}: The Connector translation job ID.

Supported
Values

Default Value

Note: You must replace & with &amp. Otherwise the
configuration file will not be valid XML, for example:
<setting name="ClayTablet.PreviewURL"
value="http://www.yourcompany.com/
preview?id={id}&amp;language={lang}
&amp;version={version}&amp;jobid=
{jobid}" />
Note: To configure this setting, uncomment this
section.
ClayTablet.Send
JobMetadata

Determines the format for sending job metadata.
To send job metadata in a format compatible
with the Connector for Sitecore version 3.6 or
higher, set this value to True.
To send job metadata in a format compatible
with the Connector for Sitecore version 3.5 or
lower, set this value to False.
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Supported
Values

Setting Name

Description

Default Value

ClayTablet.
Remove
Control
Characters

Some translation providers and translation
management systems may not be able to handle
control characters, such as 0X10 and 0X13. They
may treat an XML file with these characters as
invalid. This option instructs the Connector to
automatically remove all control (non-printing)
characters (0x00-0x1F) from an XML file before
sending it out for translation.
To automatically remove all control (nonprinting) characters from an XML file before
sending it out for translation, change this setting
to True.
To keep all control characters in an XML file sent
out for translation, keep this default setting of
False.

True
False

False

ClayTablet.
Translate
DisplayName

Supports sending out an item's display name for
translation.

true
false

false

ClayTablet.
Sitecore.
PreserveTemporaryFiles

Supports saving the temporary, generated files in
the following scenarios:

true
false

false

The Connector sends out files for translation
(source folder).
The Connector sends out files for TM update.
The Connector receives translated files from the
Platform (target folder).
Usually the Connector deletes these temporary files
when it finishes processing them. However, they
are useful for debugging and general
troubleshooting.

4.5.8.2 Configuring Translation Settings in Sitecore
You can specify a translation setting in the Sitecore user interface.
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To configure a translation setting:
1. In the Content Editor, in the content tree, navigate to the /sitecore/system/Settings/Clay Tablet
Settings/Advanced Settings folder.
Tip: Scroll down to the bottom of the Settings folder to locate the Clay Tablet Settings sub-folder.
2. Click the Advanced Settings item in the folder to open it in the Content Editor.
3. Locate the Standard fields to copy to target item section.

4. If there are standard fields to copy to target items, select them in the All list and user the arrow to move
them to the Selected list.
Note: The standard fields are usually shared and therefore identical in all versions. Therefore, they are not
usually copied or sent for translation.

4.5.9 Configuring Update-TM Settings
You can specify an Update-TM (translation memory) setting in the Sitecore user interface.

To configure Update-TM settings:
1. In the Content Editor, in the content tree, navigate to the /sitecore/system/Settings/Clay Tablet
Settings folder.
Tip: Scroll down to the bottom of the Settings folder to locate the Clay Tablet Settings sub-folder.
2. Click the Clay Tablet Settings item in the folder to open it in the Content Editor.
3. Scroll down to the Update TM section.
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4. Specify the following option:
Option

Description

Always
Update TM
using latest
target
version

This determines which target version the Connector uses to send to update a remote TM
(translation memory) server.
If this check box is cleared (default value), then the Connector always sends the target
version that is the translation to the remote TM server. If the target version was edited
post translation, then the Connector sends the version from the translation provider to
the remote TM server.
If this check box is selected, then the Connector always sends the latest available target
version to the remote TM server. If the target version was edited post translation, then
the Connector sends this update of the translation to the remote TM server.

4.5.10 Configuring Job-Metadata Settings
You can which user information the Connector includes as job metadata when it sends out jobs for translation.
By default, the Connector includes the name of the logged-in Sitecore user who creates the translation job.
However, you can configure the Connector to also include the email address of this Sitecore user.
Tip: Including the email address in the job metadata facilitates communication with the translation provider.

To configure which job metadata to include:
1. In the Content Editor, in the content tree, navigate to the /sitecore/system/Settings/Clay Tablet
Settings folder.
Tip: Scroll down to the bottom of the Settings folder to locate the Clay Tablet Settings sub-folder.
2. Click the Clay Tablet Settings item in the folder to open it in the Content Editor.
3. Scroll down to the Job metadata section.

4. Specify the following option:
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Option

Description

Send out
email of job
creator

This determines whether the email address of the Sitecore user is included in the job
metadata that the Connector sends to the translation provider.
If this check box is cleared (default value), then the Connector includes only the name of
the logged-in Sitecore user as job metadata. The Connector does not include the user's
email address in the job metadata.
If this check box is selected, then the Connector includes both the name of the logged-in
Sitecore user and the user's email address as job metadata.

4.6 Configuring Global Service Settings
The Connector has two scheduled services, the Upload Service, and Download Service, which are defined in
Sitecore scheduling. These services upload files to and download files from the Clay Tablet Translation Platform.
The default polling interval for these services is 2 minutes. You can change this interval by modifying the
following configuration file: Website_root/Website/App_Config/Include/CT3Translation.config.
The duration of the interval is expressed as hh:mm:ss.
Running these services has minimal impact on the performance of the Clay Tablet Translation Platform server,
because if there are no active jobs when they contact the server, they just wait until the next scheduled
invocation before contacting the server again. If the network is unavailable temporarily, these services log error
messages on each invocation.
Default
Value

Setting Name

Description

ClayTablet.CT3Agent.UploadService,
ClayTablet.CT2Agent

This agent polls for translation jobs to send to the
Clay Tablet Platform.

00:02:00

ClayTablet.CT3Agent.DownloadService,
ClayTablet.CT2Agent

This agent polls for translation jobs to retrieve from
the Clay Tablet Platform.

00:02:00

Note: To stop the Clay Tablet services from running, you can comment out the corresponding lines in the
CT3Translation.config file.

Note: The Sitecore Scheduler controls all scheduled applications interacting with Sitecore, and therefore it
schedules and triggers both these agents. The polling frequency of the agents cannot be more frequent than
the Sitecore Scheduler's own frequency, because it will not have an impact.
Recommended polling intervals for these agents:
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Lowest = 1 minute
Optimal = 5 minute
You can also configure the UploadService agent.
You can also configure UploadService to automatically send out all items in Translation Queue daily as single
translation job.
Note: For instructions on configuring how UploadService creates translation jobs when automatically
sending out items in the Translation Queue, see "Using Custom Logic to Configure how the UploadService
Creates Jobs when Automatically Sending Out Items from the Translation Queue" on page 92.

To configure this setting so that the Connector automatically sends all items in the Translation
Queue for translation daily:
1. Open Website_root/Website/App_Config/Include/CT3Translation.config for editing.
2. Locate the following line:
<agent type="ClayTablet.CT3Agent.UploadService, ClayTablet.CT2Agent"
method="Run" interval="00:02:00">

3. Uncomment the following lines, which follow:
<AutoSendQueueItemsTime>hh:mm</AutoSendQueueItemsTime>
<AutoSendQueueItemsJobName>AutoSendJob [{d} {t}]</AutoSendQueueItemsJobName>
<AutoSendQueueItemsUser>sitecore\admin</AutoSendQueueItemsUser>
<AutoSendQueueItemsLSP>LSP</AutoSendQueueItemsLSP>

4. Specify the following parameters in the uncommented lines:
Setting Name

Description

AutoSendQueueItemsTime

Specifies the time for sending the job from the Translation Queue out
for translation, in the folloiwng format: hh:mm.
You can use a delimiter to specify multiple times. The following example
sends a new job at 6 AM and 6 PM daily:
<AutoSendQueueItemsTime>06:00;18:00
</AutoSendQueueItemsTime>

AutoSendQueueItemsJobName Configures the job name.
{d} is a placeholder for the day the job is sent.
{t} is a placeholder for the time the job is sent.
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Setting Name

Description

AutoSendQueueItemsUser

Optional. Specifies the username for sending job. If this is not
configured, the user is Anonymous.

AutoSendQueueItemsUser

Optional. Specifies the translation provider where the Connector sends
the job. If this is not configured, then the Connector sends the job to
the default translation provider, as configured in the
ClayTablet.Account setting in Website/App_
Config/Include/CT3Translation.config.

5. Save your changes.

4.7 Configuring the Sitecore Languages in the Sitecore Content Editor
The Connector uses the Regional ISO code field of the language item in Sitecore to define the Connector
language codes. You must set up the correct Connector language codes for every Sitecore language your
company uses for translation, both source and target languages. The Connector language codes are in the
following location in the delivery package: <Delivery Package/Documents/CT3_LanguageCodes.txt>.
These language codes are also listed in "Appendix: Language Codes" on page 76.
1. Log into the Sitecore Content Editor as an administrator.
2. Navigate to sitecore/System/Languages. This is where Sitecore languages are defined.
Note: If a source or target language is not defined, you must add it to Sitecore. For detailed instructions,
refer to the Sitecore CMS Content Cookbook. This guide is available in the documentation section of the
Sitecore Developer Network (SDN) site, at http://sdn.sitecore.net/Reference.aspx. You must log in to this site
to access the documentation.
3. For each source or target language, in the Regional Iso Code field, enter the Connector language code from
the <Delivery Package/Documents/CT3_LanguageCodes.txt> file.
Note: The Connector includes error trapping for improperly configured language codes. If you make a mistake
or forget to configure a language, when you try to send out content for translation, the language is not available
for selection, and the CT Language code is misconfigured error is displayed beside the language.

4.7.1 Adding Custom Language Codes to Sitecore
You can also add custom language codes into Sitecore by editing the
Website/bin/CTAddedLanguageCodes.xml file. However you must also contact Clay Tablet and your
translation provider to ensure the custom languages are set up appropriately in the Clay Tablet Provider
Connector as well as in the Translation Management systems.
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Note: If your company sends content to your translation provider via the Clay Tablet FTP Connector on the
translation side, it is not necessary to contact Clay Tablet, because the FTP Connector automatically creates
folders based on the job name and language pairs, even for a custom language pair. However, you must inform
your translation provider about the standard language code into which to translate the content.

4.8 Configuring the Translation Workflow
Sitecore uses workflows to control when a content item is published. The Connector uses workflows to control
the translation process for a content item.
The Connector translation package installs a sample translation workflow, which you access in the Sitecore
Content Editor as an administrator by navigating to sitecore/System/Workflows/CT3 Sample
Workflow. Although you use this workflow to manage translation, you can duplicate, modify, or extend it to
support additional requirements.
For general information about workflows, refer to the appropriate version of the Sitecore CMS Content Author's
Reference and Cookbook. This guide is available in the documentation section of the Sitecore Developer
Network (SDN) site, at http://sdn.sitecore.net/Reference.aspx. You must log in to this site to access the
documentation.
The Connector supports translating Sitecore items that have been configured in the following ways:
with the Connector Sample workflow attached
with a custom workflow that includes the Connector configuration section and the associated workflow
states, which are listed and described in "Connector Workflow States" on page 55
with a custom workflow that does not have the Connector configuration section (see the following notes)
without a workflow (see the following notes)
Note: You can use the Bulk Translation feature to submit all the above types of item for translation. However, if
you want to send items for translation individually, the Translate button in the Workflow section of the Review
tab is displayed only for Sitecore items attached to CT3 Sample Workflow or to another workflow whose
base template is TranslationWorkflow, as described in "Using Your own Workflow for Translation" on page
56.
Note: You must use a translation workflow that includes the basic Connector translation steps, which are
implemented through workflow states. This ensures that the Connector can send out your content and retrieve
it from your translation provider(s). For information on Connector workflow states, see "Connector Workflow
States" on page 55.
To configure the following settings, navigate to sitecore/System/Workflows/CT3 SampleWorkflow or
your designated translation workflow.
Tip: Hover over each setting for extended help text.
You use the following settings to configure a workflow and the items attached to the workflow:
Note: For instructions on attaching items to a workflow, refer to the Clay Tablet Connector User Guide.
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Parameter

Description

Default Value

Field Types to be Sent
For Translation

Determines which types of fields the Connector can send
out for translation when it sends an item for translation.
This is relevant for all templates. If you create a custom
field type, you must add it to this list so that you can
send it out for translation.
Note: You cannot set Shared Fields to be sent out for
translation, because these fields are shared across all
versions and languages of an item.
To change these fields, click the Edit button above the
list. In the dialog box that opens, select the field types to
add, and use the blue arrow to copy them to the
Selected column. When you are done, click OK.
Tip: You can use the Shift key to select multiple
adjacent field types.

By default, the
Connector sends out
fields of the following
field types for
translation:
text
Rich Text
html
Single-Line Text
Multi-Line Text

Translate From (Source
Language)

The source language from which to translate the items.
Select a language from the list.

Usually this is the
Sitecore default
language.

Translate To (Target
Language)

The target languages that are available for translating the
items attached to the workflow. To translate into specific
target languages, select the corresponding check boxes.

n/a
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Parameter

Description

Default Value

Use Local TM (detect
changed content and
resend)

Determines whether the Use Local TM feature is
available when translating items attached to this
workflow. This feature checks each field of the source
version for any content changes, and it sends only
changed content fields out for translation, to ensure that
all target versions reflect these changes.
When this check box is selected, you can activate this
feature by selecting a check box in either the Bulk
Translation wizard or the Automatic Item Export for
Translation dialog box. The Use Local TM feature may
reduce translation costs, but it needs the Connector
translation backup data, and it increases the
Connector processing time before the Connector
sends out the items for translation.
When this check box is cleared, you cannot activate
this feature, because the related user interface is not
displayed. The Connector sends all specified source
content for translation, even if it has not changed
since it was previously sent for translation.

check box is cleared

Requested Translation
Timeframe (Days)

Determines the translation deadline when sending out
the translation automatically, without using the user
interface that supports entering this information in the
Delivery Date field. This information is sent to the
translation provider as metadata of the translation
package. If you set this parameter to 14, the deadline will
be two calendar weeks after you submit an item for
translation.
Recommendation: Discuss whether to use this feature
with your translation provider(s).

15

Workflow State to set
when Sending Content
for Translation

The workflow state to set when a source item has been
selected for translation.

/sitecore/system/
Workflows/CT3
Sample Workflow/
Sending for
Translation

Clay Tablet Connector for Sitecore Installation and Configuration Guide
Version 3.10.2

Page 52
August 16, 2017

4 Configuring the Clay Tablet Connector for Sitecore

4.8 Configuring the Translation Workflow

Parameter

Description

Default Value

Workflow State to set
(for Source Content)
once content has been
sent for translation

The workflow state to set for a source item after the
Connector has sent it out for translation. For example, in
some companies, when you send out the content for
translation, the source is ready for publishing. In this
scenario, you can set this state to Done, which is a
publishable state. Alternatively, if your company has a
final review process, you can set this to another state
that is not publishable.

By default, this state
is not set, so the
source item's state
does not change
when you send it out
for translation.

Workflow State to set
for Content while it is
out for translation

The workflow state to set for target content when an
item is being translated. The default In Translation
workflow state enables you to see which items are still
out for translation. It facilitates following up with your
translator about items that you have sent out for
translation, but that you have not yet received back.

/sitecore/system/
Workflows/CT3
Sample Workflow/In
Translation

Workflow State to set
when a translation
process has been
cancelled

The workflow state to set when an item’s translation
request has been cancelled.
A user can cancel translation from the Translation Queue.
A translation request is automatically cancelled if a fatal
error occurs while sending out an item for translation,
such as an incorrect language code, or insufficient user
permissions.

/sitecore/system/
Workflows/CT3
Sample Workflow/
Reviewing

Workflow State to set
when content
Translation is complete

The workflow state to set when an item translation has
been completed, and it is back in Sitecore for review and
publishing.

/sitecore/system/
Workflows/CT3
Sample Workflow/
Editing Translated
Version
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Parameter

Description

Default Value

Send Content
automatically using preconfigured language
settings

Enables sending all items to the Translation Queue
without further user action. That is, the Connector
automatically uses the Translate from, Translate to and
Requested Translation Timeframe information, defined
above, to immediately send content to the Translation
Queue without enabling the user to change these
parameters: the Language Selection pop-up window does
not open.
If this check box is selected, the Language Selection
pop-up window does not open when you send
content to the Translation Queue: you cannot select
the target languages or the destination, but sending
items for translation is streamlined.
If this check box is cleared, the Language Selection
pop-up window opens when you send content out for
translation: you can select the target languages, so the
process is less streamlined. However, this provides
greater control for the user.

check box is cleared

Automatically Publish
content when it reaches
the Final State

Determines whether the Connector automatically
publishes the content when an item reaches the final
state of the translation workflow.
If this check box is selected, the Connector
automatically publishes the content when an item
reaches the final state.
If this check box is cleared, the Connector does not
automatically publish the content when an item
reaches the final state.

check box is selected

Publish to which
Database?

The target databases for publishing content if the
Connector needs to publish an item.

n/a

Publish child items?

Determines whether the Connector publishes child items
when it publishes their parent item.
If this check box is selected, the Connector publishes
child items when it publishes their parent item.
If this check box is cleared, the Connector does not
publish child items when it publishes their parent
item.

check box is selected

For a list and description of Connector workflow states, see "Connector Workflow States", below.
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4.8.1 Connector Workflow States
The sitecore/System/Workflows/CT3 SampleWorkflow workflow contains all required states for the
Connector translation management process.
By default, it has the following seven states, which are listed, in order, below. Your company can modify this
translation workflow to meet your business requirements. Your company can also create your own translation
workflow, removing some of these states or adding additional states as required.
Workflow State

Relevant for Source Content

Editing

ü

Reviewing

ü

Sending for Translation

ü

Relevant for Target Content

In Translation

ü

Editing Translated Version

ü

Reviewing Translated Version

ü

Done

ü

ü

Note: Only content in the Done state is publishable.

Source content
A source content item can move through the workflow in several different ways, depending on the
configuration, which depends on your company's translation processes:
Example 1
Editing > Reviewing > Sending for Translation > Done
Example 2
Editing > Reviewing > Sending for Translation > Reviewing > Done

Target content
Similarly, a target content item can move through the workflow in several different ways, depending on the
configuration, which depends on your company's translation processes:
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Example
In Translation > Editing Translated Version > Reviewing Translated Version > Done
Note: When the state of a target content item is In Translation, that content is a copy of the source
language item. Users can use the In Translation and Editing Translated Version workflow states to
keep track of which translations have returned and which are still pending.

4.8.2 Using Your own Workflow for Translation
The sample translation workflow, sitecore/System/Workflows/CT3 Sample Workflow contains all the
fields that the Connector requires. It contains both translation settings and some information about states and
how the workflow proceeds between states. For a detailed description of these fields, see "Connector Workflow
States" on page 55.
There is a hierarchy of templates in Sitecore:
The sample translation workflow is actually a template for the workflow provided in the Connector. It links to its
parent template in the Quick info section:

The parent of this is the /sitecore/templates/System/Workflow/TranslationWorkflow base
template. If you click the link and navigate to that template, you can see its base templates:
Standard template -- This is a standard Sitecore template.
WorkflowCT3Config -- This is the Connector's top-level workflow template. It is at the top of the hierarchy.
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4.8.3 Modifying Controls in a Workflow
The Templates/ClayTablet3/WorkflowCT3Config template defines the controls in the CT3 Sample
Workflow workflow.
For example:
The Translate from leaf in the tree represents the control for defining source languages for translation.
The Type field represents the type of user-interface control used to specify the source languages.
The Source field defines the location where the Connector retrieves source languages in Sitecore.

There are multiple ways to modify controls in a workflow:
You can modify the Templates/ClayTablet3/WorkflowCT3Config template.
You can copy the values from the Templates/ClayTablet3/WorkflowCT3Config template into your
own template.
There are many ways to implement modifications:
You can remove a control. For example, if you decide you do not need a particular field, you can remove it
from WorkflowCT3Config, using the Builder tab. (The Content tab is the default tab.)
You can modify a control. For example, if you want to change a control, make a copy of the
Templates/ClayTablet3/WorkflowCT3Config template, and then make the modifications you want.
You can modify your own workflow by selecting Insert > Insert from template in the context menu, selecting
the Templates/ClayTablet3/WorkflowCT3Config template, and then selecting a control.

4.8.4 Modifying States in a Workflow
You can modify the states in a workflow and the linkages between states, which determines the workflow.
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Warning: Do not modify the values in the Data section, Type string field of states in CT3 Sample Workflow or
in states that originate from there. Otherwise, the Connector will not work property. The values in that field are
Clay Tablet classes that call the Connector functionality.
You can add or remove states from the template, or modify how the linkages between states, such as which
state follows another state. There are two recommended ways to do this:
Modify states in CT3 Sample Workflow: In the CT3 Sample Workflow folder, right-click and select Insert
> Insert from template in the context menu. Navigate to the Workflow/State template. All the states are
based on this template. Then, after you create the state within the workflow, you create an action. For
example:
To specify the next state, in the Data section, select the next state in the Next state dropdown list.
To specify the final state, in the Data section, select the Final check box. By default, the final state is the
Publish state.
Tip: First create all the states and then link them, as described above.
Copy a state to a new workflow: You can create a new state based on an existing state. To do this, select
the state you want to want to copy. Right-click and select Copying > Copy To in the context menu. Then
select the workflow where you want to copy this state, and click Copy. The copied state has the same
settings as the original state.
For more information, refer to the Sitecore CMS Workflow Cookbook. This guide is available in the
documentation section of the Sitecore Developer Network (SDN) site, at
http://sdn.sitecore.net/Reference.aspx. You must log in to this site to access the documentation.
Note: Your custom workflow must include the required translation statuses.

4.8.5 Changing the Base Template of Your Workflow
To change the base template of your workflow, so that you can use it with the Connector to manage
translations:
1. In the navigation pane, select your workflow that you want to use as a translation workflow. For example,
select sitecore\System\Workflow\MyWorkflow.
2. In the ribbon, click the Configure tab.
3. In the Template section of the Configure tab, click Change.
4. In the Select the Template page of the wizard, navigate to
Templates\System\Workflow\TranslationWorkflow, and click Next.

Clay Tablet Connector for Sitecore Installation and Configuration Guide
Version 3.10.2

Page 58
August 16, 2017

4 Configuring the Clay Tablet Connector for Sitecore

4.9 Filtering Fields in Items that Do Not Need Translation

5. In the Change page of the wizard, click Next to confirm this change.
6. Click Finish.

4.9 Filtering Fields in Items that Do Not Need Translation
You can use the Translation Filter window to filter out fields that never need translation. You can access this
feature from either the Sitecore Content Editor or the Sitecore Desktop (Sitecore 6 and 7 only).
You initially specify which types of fields the Connector sends for translation using the Field Types to be Sent
For Translation workflow-level parameter. For details, see "Configuring the Translation Workflow" on page 50.
You use the Translation Filter feature to further exclude certain types of fields from content that the Connector
sends for translation, per the template. You can create filters when initially configuring the Connector, or you
can create or update the filters at any time.
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When a user sends out an item for translation, the Connector collects the content from all fields in the item with
the field types specified in that parameter, in preparation for sending them out for translation. Then, if there are
some fields that you do not want to send for translation, even though they belong to field types that the
Connector sends out for translation, you can use the Translation Filter to exclude them.
1. Do one of the following to open the Translation Filter window:
In the Sitecore Content Editor ribbon, click the CTC Translation tab, and then in the Translation Tools
section, click Translation Filter.

In the Sitecore Desktop, click the Sitecore menu, and then select All Applications > CTC Translation >
Translation Filter from the menu. (Sitecore 6 and 7 only)
The Translation Filter window opens.
If you use the Sitecore Content Editor in Sitecore 6 or 7, it opens in a separate browser window.
If you use the Sitecore Content Editor in Sitecore 8 or the Sitecore Desktop, it opens in the same browser
window.

2. Click the Add button

to add a new filter.

The Welcome page of the Field Filter wizard opens.
3. Click Next.
The Choose a Content Template page of the Field Filter wizard opens.
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4. Select the content template to associate with the fields you want to filter, and exclude from translation. Use
the Expand and Collapse icons to navigate the tree. Click Next.
The Select Fields that you don't want sent out for translation page of the Field Filter wizard opens.
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This page displays the following information about all the fields in the template you selected:
Column

Description

Field

The name of a field type in the template.

Type

The description of the field type.

Shared

Indicates whether the field type is shared.

Template

The template where the field type is located.

5. Select the check boxes of the field types you want to exclude from translation, and click Next.
Note: Shared fields are never sent for translation, so they are automatically excluded from translation. You
do not need to select them.
The Don't transfer field value page of the Field Filter wizard opens.
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This page displays only the field types you selected in the previous page of the wizard.
6. For each field type, indicate whether you want the Connector to copy the source-language content to the
target version.
If you do not want the Connector to copy the source-language content of a field type to the target
version, select the corresponding check box. This field type will be excluded from the target content.
If you want the Connector to copy the source-language content of a field type to the target version, clear
the corresponding check box. This field type will be included in the target content; however, the content
will be in the source language.
Click Next.
The summary page of the wizard opens.
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This page displays the following information about the fields to exclude in the new filter.
Column

Description

Template

The name of the template where the field type to exclude from translation is located.

Field

The name of the field type to exclude from translation.

Type

The type of field to exclude from translation.

Don't transfer
field value

Indicates whether the Connector copies the source-language content to the target
version for this field type.
Blank indicates that the Connector does copy the source-language content of a field
to the target version, select the corresponding check box. This field will be included in
the target content; however, it will be in the source language.
yes indicates that the Connector does not copy the source-language content of a
field type to the target version. The Connector does not automatically transfer the
value of the field in the source version to the field in the target version.

7. Click Finish.
8. Sitecore 8 only. A message box opens, confirming that you want to close the wizard. Click OK.
The wizard closes, and the Translation Filter window displays each filter you created in a separate row:
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This window displays the following information about the filters:
Column

Description

Template
Path

The path and name of the template. Field types in this template can be excluded from
translations.

Field
Name

When the Connector sends out content items based the specified template for translation, it
does not send out this field's content for translation.

Field
Type

The type of this field to exclude from translation. When [ALL] is displayed, then all types of
this field are excluded from translation.

Don't
transfer
field
value

Indicates whether the Connector copies the source-language content to the target version for
this field type.
false indicates that the Connector does copy the source-language content of a field type
to the target version, select the corresponding check box. This field will be included in the
target content, however it will be in the source language.
true indicates that the Connector does not copy the source-language content of a field to
the target version. The Connector does not automatically transfer the value of the field in
the source version to the field in the target version.

Now that you have created a filter, you can perform the following actions in the CTC Translation Filter
window (in addition to the Add Filter button, which was described above in step 3):
Button

Description
Deletes all filters displayed in the CTC Translation Filter window.
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4.10 Configuring Connector Roles and Adding Users

Description
Deletes all selected filters from the CTC Translation Filter window.

Applies the selected filter to all templates with the same field type.

Refreshes the list of displayed filters.

4.10 Configuring Connector Roles and Adding Users
The Connector installs the roles described below into Sitecore:
Role

Description

sitecore\Translation
Administrator

Users added to this role can set translation filters, remove completed job status, and
delete the Connector backup data. Users can submit content to the translation queue
or send it out immediately to translation.

sitecore\Translation
Operator

Users added to this role can submit content to the translation queue. They can also
send items from the queue for translation and remove items from the queue. When
using the Bulk Translation feature, these users can skip the translation queue. They
cannot send out individual content items directly to translation.

sitecore\
Translation
ItemSent
Notification
Receiver

Users added to this role receive email notifications from the Connector when it sends
items out for translation.

sitecore\
Translation
ItemCompleted
Notification
Receiver

Users added to this role receive email notifications from the Connector when it
receives translated items back from translation.

You must assign your users to these roles so they can access the functionality described above. For detailed
instructions, refer to the Sitecore CMS Security Administrator's Cookbook. This guide is available in the
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documentation section of the Sitecore Developer Network (SDN) site, at
http://sdn.sitecore.net/Reference.aspx. You must log in to this site to access the documentation.

4.11 Configuring Freeway and Login Credentials
Note: This section is relevant only if you are using the Special Edition for Lionbridge Freeway.
If the Connector is configured with your Freeway login credentials, then when you send content for translation,
the Connector automatically retrieves the analysis codes set up for your company in Lionbridge. When you
submit content for translation to Freeway, you can select the appropriate analysis codes. This determines how
Lionbridge processes your company's translation projects.

After you install the Connector package:
1. Configure the Connector to use the Freeway integration.
a. Open the following configuration file for editing: Website_root/Website/App_
Config/Include/CT3Translation.config .
b. Locate the ClayTablet.AccountIsFreeway setting, and set its value to True.
Note: If your company is not using the Freeway integration, this setting is not required.
c. Save your change and close the file.
2. Enter your company's Freeway login credentials.
a. Open the following file for editing: Website\App_Config\Include\Freeway.config.
b. Enter your client-specific values for the following parameters: Freeway.ServerURL,
Freeway.LoginName, and Freeway.LoginPassword.
c. Save your change and close the file.
Warning: This configuration is required for full integration between the Connector and Freeway. Otherwise,
the Connector cannot retrieve and display analysis code options, and the user cannot specify analysis codes
for projects submitted to Freeway. However, even without this configuration, the Connector can still send
submitted content to Freeway.

4.12 Configuring the In-Context Preview Feature
You can configure the settings for the In-Context Preview feature. This feature enables those without Sitecore
access (such as translators) to preview items for translation as Sitecore would render them.
Warning: This feature is currently in alpha testing. It is not currently generally available for production usage. Do
not configure this feature unless you have contacted Clay Tablet and arranged to be an alpha tester of this
feature. If you are not an alpha tester of this feature, leave all these settings blank.
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To configure the In-Context Preview feature:
1. In the Content Editor, in the content tree, navigate to the /Sitecore/System/Settings/Clay Tablet
Settings folder.
Tip: Scroll down in the Settings folder to locate the Clay Tablet Settings sub-folder.
2. Click the Clay Tablet Settings item in the folder to open it in the Content Editor.
3. Scroll down to the Preview section.

4. Specify the following settings:
Tip: You can use the parameters listed in the table below this table to configure the URLs.
Setting

Description

Sample Value

Preview
URL

The URL that the Clay Tablet Preview server uses to access the
Sitecore instance and preview the source version of the item
sent to translation. Typically this server needs access through
your firewall to access the URL and credentials to log into your
Sitecore instance.

http://yoursitecoreurl/?sc_
itemid={id}&sc_
mode=preview&sc_lang=
{lang}

Preview
URL for
Target
Language

The URL that the Clay Tablet Preview server uses to access the
Sitecore instance and preview the target version of the item
sent to translation. Typically this server needs access through
your firewall to access the URL and credential to log into your
Sitecore instance.

http://yoursitecoreurl/?sc_
itemid={id}&sc_
mode=preview&sc_lang=
{targetlang}
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Setting

Description

Sample Value

External
Preview
URL

The URL that enables translators or external reviewers to
preview the source item on the Clay Tablet Preview server. For
instructions on configuring this setting, contact Clay Tablet
Support, as described in "How to Contact Clay Tablet Support"
on page 10.

https://ct-preview-serverurl?chunk={chunkid}
&lang={lang}

External
Preview
URL for
Target
Language

The URL that enables translators or external reviewers to
preview the target item the Clay Tablet Preview server. For
instructions on configuring this setting, contact Clay Tablet
Support, as described in "How to Contact Clay Tablet Support"
on page 10.

https://ct-preview-serverurl?chunk={chunkid}
&lang={targetlang}

You can use the following parameters listed in the table below to configure the URLs described above:
Parameter

Description

{id}

The identifier of the source Sitecore item sent for translation.

{version}

The version of the source Sitecore item sent for translation.

{lang}

The source language of the Sitecore item sent for translation.

{targetversion}

The version of the translated Sitecore item.

{targetlang}

The target language of the translated Sitecore item.

{jobid}

The Connector translation job ID.

{chunkid}

The globally unique ID generated by the Connector, which identifies each translatable
field (chunk) in the XML file generated by Clay Tablet.
Note: This parameter is relevant only to the External Preview URL and External
Preview URL for Target Language settings, described above.
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Clay Tablet provides an optional enhanced Workbox, which has more features than the standard Sitecore
Workbox. Installing Clay Tablet's enhanced Workbox updates and replaces the original Sitecore Workbox.
This Workbox supports much more powerful management of large lists of items in a workflow. You can sort by
different column headings, approve many items at once and manage the display of long lists easily.
Important: Install Clay Tablet's enhanced Workbox only if you are comfortable with modifying the standard
Sitecore Workbox.

To install the enhanced Workbox:
1. On the Sitecore Desktop, on the Windows Start menu, select Sitecore > Development Tools > Installation
Wizard.
The Welcome page of the Sitecore Install Package wizard opens.
2. Click Next.
The Select Package page of the Sitecore Install Package wizard opens.
3. Click Browse, and locate the Workbox installation package, CT_Sitecore_WorkBox_update-x.y.z.zip,
where x.y.z is the current version number of the Connector for Sitecore.
Tip: The installation package is in the following location in the delivery package: <Delivery
Package/Workbox/CT_Sitecore_WorkBox_update-x.y.z.zip>.
4. Click Upload to upload the package.
5. After the package is uploaded, click Next.
6. Follow any on-screen instructions to finish installing the Workbox package into Sitecore.
7. Do one of the following:
Sitecore 6.4 and higher, Sitecore 7, and Sitecore 8.0: On the Sitecore server, navigate to the
web.config file and open it in a text editor. For example, the location of this file may be
C:\inetpub\wwwroot\Sitecore66\Website.
Sitecore 8.1: On the Sitecore server, navigate to the sitecore.config file and open it in a text editor.
For example, the location of this file may be C:\inetpub\wwwroot\Sitecore81\Website\App_
Config.
8. Search for workflowProvider.
Note: There are two places where workflowProvider is configured, one for the core database (in the
section starting with <!-- core -->), and the other for the master database (in the section starting with
<!-- master -->),. You change only the workflowProvider section for the master database.
9. Comment out the workflowProvider section for the master database.
10. Add the following section instead:
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<workflowProvider hint="defer"
type="Sc.ClayTablet.WorkboxEx.SortingWorkflowProvider, Sc.ClayTablet.WorkboxEx">
<param desc="database">$(id)</param>
<param desc="history store" ref="workflowHistoryStores/main" param1="$(id)"/>
</workflowProvider>

11. Verify that after editing, the relevant section in the web.config or sitecore.config file is similar to the
following:
<database id="master" singleInstance="true" type="Sitecore.Data.Database,
Sitecore.Kernel">
......
<!-<workflowProvider hint="defer
type="Sitecore.Workflows.Simple.WorkflowProvider,
Sitecore.Kernel">
<param desc="database">$(id)</param>
<param desc="history store" ref="workflowHistoryStores/main" param1="$(id)
"/>
</workflowProvider>
-->

<workflowProvider hint="defer"
type="Sc.ClayTablet.WorkboxEx.SortingWorkflowProvider,
Sc.ClayTablet.WorkboxEx">
<param desc="database">$(id)</param>
<param desc="history store" ref="workflowHistoryStores/main" param1="$(id)
"/>
</workflowProvider>
.......

12. Save the web.configor sitecore.config file.
Sitecore restarts.
For information on using the enhanced Workbox, refer to the Clay Tablet Connector for Sitecore User Guide.
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After you complete the configuration, your Clay Tablet Connector for Sitecore installation is ready for testing.
We recommend sending only a few pages for translation in one language as an initial test. For detailed
instructions, refer to the Clay Tablet Connector for Sitecore User Guide. Once successful, you can send as many
languages as required.
Please coordinate with your translation provider for this test process.
If you have any concerns or questions, please contact Clay Tablet Support. For details, see "How to Contact Clay
Tablet Support" on page 10.
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7 Appendix: Connector Translation File Formats
7.1 XML Translation File – New Translation
The following is an example of new content that the Connector sends for translation:
<TranslationContent CT2ProjectId="5ab2e78e-e427-4b89-9629-562c13584d94"
CT2AssetId="9250c3ee-da56-47d8-880e-2514052d7a58" CT2SourceLanguageCode="en-US"
CT2TargetLanguageCode="fr-FR" SitecoreSourceLanguageCode="en"
SitecoreTargetLanguageCode="fr-FR">
<SitecoreItem DatabaseName="master" ItemId="{E6F3AA2D-3E5B-47A5-8B4A1EA603C9A3FA}" ItemSourceVersion="1" ItemTargetVersion="1"
TranslationDeadline="">
<FieldContent FieldName="Title">Demo content to translate</FieldContent>
<FieldContent FieldName="Body">
&lt;p&gt;This is content that google will try to translate&lt;/p&gt;
</FieldContent>
</SitecoreItem>
</TranslationContent>

7.2 HTML Translation File – New Translation with Metadata in Comments
The following is an example of new content that the Connector sends for translation, with metadata in the
comments:
<!--CT2Translation:[From:en-US To:fr-FR]-->
<!--CT2SharedMeta:92d2c042-2bcf-41cd-8a04-fe4d327f2157|45525ffe-fdf1-403f-be6a43bcd99e3373|en|fr-FR|en-US|fr-FR:SharedMetaEnd-->
<!--CT2FieldMeta:master|{C069745D-63F6-4EB1-868F-EF1AE7C0BB76}|2|10|Title:Begin-->
Title of demo2
<!--CT2MetaField::End-->
<!--CT2FieldMeta:master|{C069745D-63F6-4EB1-868F-EF1AE7C0BB76}|2|10|Body:Begin-->
<p> Body of demo2 </p>
<!--CT2MetaField::End-->

Clay Tablet Connector for Sitecore Installation and Configuration Guide
Version 3.10.2

Page 73
August 16, 2017

7 Appendix: Connector Translation File Formats

7.3 XML Translation File – Correction Requested

7.3 XML Translation File – Correction Requested
The following is an example of a request to correct the translation:
<TranslationCorrectionContent CT2ProjectId="3149ca06-64f8-4e07-afb1-57a7c3539670"
CT2AssetId="08a44fe1-a650-4dc7-bca5-c63e6cd0a4f7" CT2SourceLanguageCode="en-US"
CT2TargetLanguageCode="el-GR" SitecoreSourceLanguageCode="en"
SitecoreTargetLanguageCode="el-GR" DatabaseName="master" ItemId="{6C95A5D0-30D14329-95BD-E9C8FF71FD07}" ItemSourceVersion="1" ItemTargetVersion="4">
<Notes>
</Notes>
<ItemFields>
<ItemField FieldName="Title">
<SourceContent>Smartphone traffic is up 193% in a year</SourceContent>
<TargetContent>Smartphone κίνηση είναι επάνω 193% σε ένα
χρόνο</TargetContent>
</ItemField>
</ItemFields>
</TranslationCorrectionContent>

7.4 HTML Translation File – Correction Requested with Metadata in Comments
The following is an example of a request to correct the translation with metadata in the comments:
<!--CT2TranslationCorrection:[From:en-US To:de-DE]-->
<!--CT2SharedMeta:95e71b0c-5e75-4a34-8cf7-e706d7edff2d|f366b6e9-78c9-438a-b67a37a938257889|en|de-DE|en-US|de-DE:SharedMetaEnd-->
<!--CT2ItemMeta:master|{333E5B70-BA26-402B-A3CE-5A5FBAFF7D66}|4|9:ItemMetaEnd-->
<!--CT2Note::Begin-->
The translation of the title needs correction
<!--CT2Note::End-->
<!--CT2FieldMeta:Title:Begin-->
<!--Source Content::Begin-->
Smartphone traffic is up 193% in a year
<!--Source Content::End-->
<!--Translated Content::Begin-->
Smartphone-Verkehr ist bis 193% in einem Jahr
<!--Translated Content::End-->
<!--CT2MetaField::End-->
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7.5 Translation Memory Update File
In the following example, a user corrected the translation and it must be sent back to the translation provider to
update the remote translation memory (TM):
<UpdateTMContent CT2SourceLanguageCode="en-US" CT2TargetLanguageCode="da-DK"
SitecoreSourceLanguageCode="en" SitecoreTargetLanguageCode="da-DK">
<ContentCorrections>
<ContentCorrection>
<SourceContent>Smartphone traffic is up 193% in a year</SourceContent>
<TargetContent>Smartphone trafik er op 193% på et år</TargetContent>
</ContentCorrection>
<ContentCorrection>
<SourceContent>
&lt;p&gt;Smartphone traffic is up. Feature phone share is down. And
traffic from mobile Internet devices (like the iPod touch) that don't
have built-in phones is booming — even before Apple releases the
iPad.&lt;/p&gt;
&lt;p&gt;That's the thrust of the the latest report by AdMob, the mobile
advertising network snapped up last fall by Google (&lt;a
href="http://money.cnn.com/quote/quote.html?symb=GOOG"
rel="external"&gt;GOOG&lt;/a&gt;) before Apple (&lt;a
href="http://money.cnn.com/quote/quote.html?symb=AAPL"
rel="external"&gt;AAPL&lt;/a&gt;) could buy it.&lt;/p&gt;</SourceContent>
<TargetContent>&lt;p&gt; Smartphone trafik er op. Feature telefon andel er
nede. Og trafik fra det mobile internet-enheder (ligesom iPod touch), der
ikke har indbygget telefoner boomer - selv før Apple frigiver IPAD.
&lt;/p&gt;&lt;p&gt; Det er essensen af den seneste rapport fra admob, det
mobile annoncenetværk snapped op sidste efterår af Google ( &lt;a
href="http://money.cnn.com/quote/quote.html?symb=GOOG"
rel="external"&gt;GOOG&lt;/a&gt; ) før Apple ( &lt;a
href="http://money.cnn.com/quote/quote.html?symb=AAPL"
rel="external"&gt;AAPL&lt;/a&gt; ) kunne købe det.
&lt;/p&gt;</TargetContent>
</ContentCorrection>
</ContentCorrections>
</UpdateTMContent>
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For detailed instructions on setting up the correct Connector language codes for every Sitecore language your
company uses for translation, see "Configuring the Sitecore Languages in the Sitecore Content Editor" on page
49.
The Clay Tablet Connector has the following language codes:
Language Identifier

Language Code

Afrikaans

"af-ZA"

Albanian

"sq-AL"

Amharic

"am-ET"

Arabic_Algeria

"ar-DZ"

Arabic_Bahrain

"ar-BH"

Arabic_Egypt

"ar-EG"

Arabic_Iraq

"ar-IQ"

Arabic_Jordan

"ar-JO"

Arabic_Kuwait

"ar-KW"

Arabic_Lebanon

"ar-LB"

Arabic_Libya

"ar-LY"

Arabic_Morocco

"ar-MA"

Arabic_Oman

"ar-OM"

Arabic_Qatar

"ar-QA"

Arabic_Saudi_Arabia

"ar-SA"

Arabic_Syria

"ar-SY"

Arabic_Tunisia

"ar-TM"

Arabic_UAE

"ar-AE"

Arabic_Yemen

"ar-YE"

Armenian

"hy-AM"
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Language Identifier

Language Code

Assamese

"as-IN"

Basque

"eu-ES"

Belarusian

"be-BY"

Bengali_Bangladesh

"bn-BD"

Bengali_India

"bn-IN"

Bosnian_Bosnia_Herzegovina

"bs-BA"

Bulgarian

"bg-BG"

Burmese

"my-MM"

Catalan

"ca-ES"

Chinese_Hong_Kong

"zh-HK"

Chinese_Macao

"zh-MO"

Chinese_PRC

"zh-CN"

Chinese_Singapore

"zh-SG"

Chinese_Taiwan

"zh-TW"

Croatian

"hr-HR"

Croatian_Bosnia_Herzegovina

"hr-BA"

Czech

"cs-CZ"

Danish

"da-DK"

Divehi

"dv-MV"

Dutch

"nl-NL"

Dutch_Belgium

"nl-BE"

English_Australia

"en-AU"

English_Belize

"en-BZ"
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Language Identifier

Language Code

English_Canada

"en-CA"

English_HongKong

"en-HK"

English_India

"en-IN"

English_Indonesia

"en-ID"

English_Ireland

"en-IE"

English_Jamaica

"en-JM"

English_Malaysia

"en-MY"

English_New_Zealand

"en-NZ"

English_Philippines

"en-PH"

English_Singapore

"en-SG"

English_South_Africa

"en-ZA"

English_Trinidad

"en-TT"

English_UK

"en-GB"

English_US

"en-US"

English_Zimbabwe

"en-ZW"

Estonian

"et-EE"

Faroese

"fo-FO"

Farsi

"fa-IR"

Filipino

"fil-PH"

Finnish

"fi-FI"

French

"fr-FR"

French_Belgium

"fr-BE"

French_Cameroon

"fr-CM"
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Language Identifier

Language Code

French_Canada

"fr-CA"

French_Cote_d_Ivoire

"fr-CI"

French_Democratic_Rep_Congo

"fr-CD"

French_Haiti

"fr-HT"

French_Luxembourg

"fr-LU"

French_Mali

"fr-ML"

French_Monaco

"fr-MC"

French_Morocco

"fr-MA"

French_Reunion

"fr-RE"

French_Senegal

"fr-SN"

French_Switzerland

"fr-CH"

Frisian_Netherlands

"fy-NK"

Fulfulde_Nigeria

"ff-NG"

FYRO_Macedonian

"mk-MK"

Gaelic_Ireland

"gd-IE"

Gaelic_Scotland

"gd-GB"

Gallegan

"gl-ES"

Georgian

"ka-GE"

German

"de-DE"

German_Austria

"de-AT"

German_Liechtenstein

"de-LI"

German_Luxembourg

"de-LU"

German_Switzerland

"de-CH"
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Language Identifier

Language Code

Greek

"el-GR"

Guarani

"gn-PY"

Gujarati

"gu-IN"

Hausa

"ha-NE"

Hawaiian

"haw-US"

Hebrew

"he-IL"

Hindi

"hi-IN"

Hungarian

"hu-HU"

Icelandic

"is-IS"

Igbo

"ig-NG"

Indonesian

"id-ID"

Inuktitut

"iu-CA"

Italian

"it-IT"

Italian_Switzerland

"it-CH"

Japanese

"ja-JP"

Kannada

"kn-IN"

Kanuri

"kr-TD"

Kashmiri

"ks-IN"

Kazakh

"kk-KZ"

Khmer

"km-KH"

Konkani

"kok-IN"

Korean

"ko-KR"

Kyrgyz

"ky-KZ"

Clay Tablet Connector for Sitecore Installation and Configuration Guide
Version 3.10.2

Page 80
August 16, 2017

8 Appendix: Language Codes

Language Identifier

Language Code

Lao

"lo-LA"

Latin

"la-XL"

Latvian

"lv-LV"

Lithuanian

"lt-LT"

Malay

"ms-MY"

Malay_Brunei_Darussalam

"ms-BN"

Malayalam

"ml-IN"

Maltese

"mt-MT"

Maori

"mi-NZ"

Marathi

"mr-IN"

Mongolian

"mn-MN"

Nepali

"ne-NP"

Nepali_India

"ne-IN"

Norwegian

"nb-NO"

Norwegian_Nynorsk

"nn-NO"

Oriya

"or-IN"

Oromo

"om-ET"

Panjabi

"pa-PK"

Polish

"pl-PL"

Portuguese

"pt-PT"

Portuguese_Brazil

"pt-BR"

Punjabi_Pakistan

"pa-PK"

Pushto

"ps-AF"
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Language Identifier

Language Code

Quechua_Ecuador

"qu-EC"

Quechua_Peru

"qu-PE"

Rhaeto_Romance

"rm-IT"

Romanian

"ro-RO"

Romanian_Moldova

"ro-MD"

Russian

"ru-RU"

Russian_Moldava

"ru-MD"

Sami

"se-NO"

Sanskrit

"sa-IN"

Serbian_Cyrillic

"sr-RS"

Serbian_Latin

"sr-SP"

Sindhi_India

"sd-IN"

Sindhi_Pakistan

"sd-PK"

Sinhala

"si-LK"

Slovak

"sk-SK"

Slovenian

"sl-SI"

Somali

"so-ET"

Sorbian

"wen-DE"

Spanish

"es-ES"

Spanish_Argentina

"es-AR"

Spanish_Bolivia

"es-BO"

Spanish_Chile

"es-CL"

Spanish_Colombia

"es-CO"
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Language Identifier

Language Code

Spanish_Costa_Rica

"es-CR"

Spanish_Dominican_Republic

"es-DO"

Spanish_Ecuador

"es-EC"

Spanish_El_Salvador

"es-SV"

Spanish_Honduras

"es-HN"

Spanish_LatinAmerica

"es-XL"

Spanish_Mexico

"es-MX"

Spanish_Nicaragua

"es-NI"

Spanish_Panama

"es-PA"

Spanish_Paraguay

"es-PY"

Spanish_Peru

"es-PE"

Spanish_Puerto_Rico

"es-PR"

Spanish_Uruguay

"es-UY"

Spanish_US

"es-US"

Spanish_Venezuela

"es-VE"

Swahili

"sw-TZ"

Swedish

"sv-SE"

Swedish_Finland

"sv-FI"

Syriac

"syr-SY"

Tajik

"tg-TJ"

Tamil

"ta-IN"

Tatar

"tt-RU"

Telugu

"te-IN"
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Language Identifier

Language Code

Thai

"th-TH"

Tibetan

"bo-CN"

Tigrinya_Eritrea

"ti-ER"

Tigrinya_Ethiopia

"ti-ET"

Tsonga

"ts-ZA"

Tswana

"tn-BW"

Turkish

"tr-TR"

Turkmen

"tk-TM"

Uighur

"ug-CN"

Ukrainian

"uk-UA"

Urdu

"ur-PK"

Urdu_India

"ur-IN"

Uzbek

"uz-UZ"

Venda

"ve-ZA"

Vietnamese

"vi-VN"

Welsh

"cy-GB"

Xhosa

"xh-ZA"

Yi

"ii-CN"

Yiddish

"yi-MD"

Yoruba

"yo-NG"

Zulu

"zu-ZA"
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9 Appendix: Connector Extensions
You can create the following extensions to the Connector:
"Configuring the Behavior of the Send Dependent Items check box" on page 85
"Using Custom Logic to Update a Remote TM" on page 86
"Calling Custom Workflow Logic" on page 89
"Using Custom Logic to Overwrite the Workflow Target-Language Setting when Automatically Sending Items
to the Translation Queue via Workflow" on page 91
"Using Custom Logic to Configure how the UploadService Creates Jobs when Automatically Sending Out
Items from the Translation Queue" on page 92
"Using Custom Logic to Populate the Translation Queue" on page 95

9.1 Configuring the Behavior of the Send Dependent Items check box
The Send Dependent Items check box is displayed in:
the Choose Items page of the Bulk Translation wizard
the Automatic Item Export for Translation dialog box
By default, if the Send Dependent Items check box is selected in the Choose Items page of the Bulk Translation
wizard, the Connector sends out data source items from the layout and final layout of the item itself.
Alternatively, you can develop your own pipeline to determine which dependent items the Connector sends for
translation when this check box is selected. You configure this pipeline in the <pipelines> section of the
Website_root/Website/App_Config/Include/CT3Translation.config configuration file. If the Send
Dependent Items check box is selected and the pipeline is defined, then when you run the Bulk Translation
wizard:
1. The Connector calls the pipeline for each selected item.
2. On its own, the pipeline finds dependent items recursively.
Important: The pipeline overrides the default Connector behavior of sending out only data source items of
the item itself. The Connector does not call the pipeline again using a dependent item as a source for
recursively searching for additional dependent items.
3. The Connector adds the results to the list of items to send out for translation.

To develop a pipeline:
1. Insert the logic to recursively determine all dependent items of an item to send out for translation, similar to
the following example:
<CustomRecursiveDependentItemsPipeline>
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<!-- Insert the logic to recursively determine all dependent items of an item to
send out for translation.
-->
<processor type="Your.Class, Your.Assembly" method="getDependentItems"/>
</CustomRecursiveDependentItemsPipeline>

2. Ensure that the processor method has the following signature:
public void getDependentItems(ClayTablet.SC.Pipelines.DependentItemsPipelineArgs
args);

3. Use the args parameter to retrieve information about a source item. You will search for dependent items of
this source:
public class DependentItemsPipelineArgs {
String ItemDatabase { get; }
String ItemId { get; }
String SourceLanguage { get; }
String SourceVersion { get; }
String[] TargetLanguages { get; }
List<String> DependentItems { get; }
}

4. Insert the item IDs of all dependent items of the source item into the DependentItems that the pipeline
returns.

9.2 Using Custom Logic to Update a Remote TM
You can call the <SendTmUpdatePipeline> pipeline to send out updates to a remote TM (translation
memory) of selected items and versions for which the translated versions were updated.

To call this pipeline:
1. Create an instance of ClayTablet.SC.Pipelines.SendTmUpdatePipelineArgs class to pass to the
pipeline as an argument. The SendTmUpdatePipelineArgs class is defined in ClayTablet.SC.dll as:
public class SendTmUpdatePipelineArgs : PipelineArgs
{
public String SourceLanguage { get; set; }
public String TargetLanguage { get; set; }
public void AddTmUpdateItem(string itemId, int sourceVersion, int
targetVersion);
public List<TmUpdateItem> TmUpdateItems { get; }
}
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2. In SendTmUpdatePipelineArgs, specify the following information:
Information

Description

ItemId

The Sitecore item ID of each updated item to send to the remote TM.

SourceLanguage

The source language of the updated items to send to the remote TM.

TargetLanguage

The target language of the updated items to send to the remote TM.

AddTmUpdateItem

Call this one or more times to add a set of
ItemId/SourceVersion/TargetVersion to the list.

SourceVersion

The source-language version of the updated items to send to the remote TM.

TargetVersion

The target-language version of the updated items to send to the remote TM.

Note: Invoking the pipeline once can update the remote TM for multiple Sitecore items with the same source
and target languages.
3. Invoke the pipeline to send the the specified Sitecore items with the same source and target languages to
update the remote TM.
4. Use the SendTmUpdatePipelineArgs.TmUpdateItems class to verify that an item has actually been
sent out to update a remote TM. class is defined in ClayTablet.SC.dll as:
public class TmUpdateItem
{
public string ItemId { get; }
public int SourceVersion { get; }
public int TargetVersion { get; i}
public int TargetVersionUsedForTmUpdate { get; }
public bool Updated { get; }
}

You specify the following information:
Information

Description

ItemId

The Sitecore item ID of each updated item to send to the remote TM.

SourceVersion

The source-language version of the updated items to send to the
remote TM.

TargetVersion

The target-language version of the updated items to send to the
remote TM.

TargetVersionUsedForTmUpdate

The version of the updated target items to send to the remote TM.
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5. Inspect the TmUpdateItem.Updated property to verify that an item has actually been sent out to update a
remote TM.
6. If an item was not actually sent out to update a remote TM, investigate the following possible reasons:
The target version was not updated after the translation was received.
The Connector did not find a translation record associated for the Sitecore item ID and the specified
source and target version combination.
7. If neither of the reasons in the previous step is relevant, then check the Clay Tablet and Sitecore log files to
determine whether any unexpected errors occurred during the TM update process.
8. To verify which target version was sent to update the remote TM, inspect the
TmUpdateItem.TargetVersionUsedForTmUpdate property. Typically the Connector uses the target
version specified in the arguments to update the remote TM.
However, if the Always Update TM using latest target version check box is selected in the
/sitecore/system/Settings/Clay Tablet Settings/Clay Tablet Settings item, the pipeline
uses the latest target version instead of the specified target version, and
TmUpdateItem.TargetVersionUsedForTmUpdate returns that version number. If the Connector does
not send out item to update a remote TM, then TmUpdateItem.TargetVersionUsedForTmUpdate is
not specified.
Note: When you use the pipeline to send out multiple items to update a remote TM, then the Connector
groups the items in the same way that it grouped the original items for translation in an XML file. Items that
were originally in the same XML file (asset task file) are sent out in the same TM update file.

Sample code for calling the pipeline:
SendTmUpdatePipelineArgs pArgs = new SendTmUpdatePipelineArgs();
pArgs.SourceLanguage = _itemSourceLanguageName;
pArgs.TargetLanguage = _itemTargetLanguageName;
pArgs.AddTmUpdateItem(_itemID, _itemSourceVersion, _itemTargetVersion);
CorePipeline.Run("SendTmUpdatePipeline", pArgs);
int tmUpdatedCount = 0;
foreach (TmUpdateItem updateItem in pArgs.TmUpdateItems)
{
if (updateItem.Updated)
{
tmUpdatedCount++;
}
}
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9.3 Calling Custom Workflow Logic
The Connector can call custom logic when it sends out items for translation and when content returns from
translation.

To configure custom logic for when the Connector sends out items for translation:
1. In the Website_root/Website/App_Config/Include/CT3Translation.config configuration file,
add the <CustomSendItemsPipeline> (after existing <SendItemPipeline> section to call
custom logic after the Connector sends out items for translation. This section can be similar to the following:
<CustomSendItemsPipeline>
<processor type="Your.Class, Your.Assembly" method="YourMethod" />
</CustomSendItemsPipeline>

2. Ensure that the processor method has the following signature:
public void Your.Class.YourMethod (Sitecore.Pipelines.PipelineArgs arg);

3. You can retrieve the following information from the arg parameter:
Information

Description

arg.CustomData
["Database"]
(String)

The Sitecore database that contains the item sent out for translation.

arg.CustomData
["ItemId"] (String)

The identifier of the Sitecore item sent out for translation.

arg.CustomData
["SourceLanguage"]
(String)

The Sitecore language code of the source language.

arg.CustomData
["SourceVersion"]
(int)

The version of Sitecore item sent out for translation.

arg.CustomData
["TargetLanguage"]
(String)

The Sitecore language code of the target language.

arg.CustomData
["TargetVersion"]
(int)

The target version of the Sitecore item.
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Information

Description

arg.CustomData
["JobId"] (String)

The identifier of the Clay Tablet job that contains the item sent out for translation.

arg.CustomData
["AssetId"] (String)

The identifier of Clay Tablet asset that contains the item sent out for translation. An
asset can contain multiple Sitecore items, because the Connector aggregates
multiple items into one XML to send out for translation.

To configure custom logic for when the Connector receives translated content:
1. In the Website_root/Website/App_Config/Include/CT3Translation.config configuration file,
add the <CustomHandleTranslatedItemPipeline> (after existing <SendItemPipeline>
section to call custom logic after the Connector receives the translated content. This section can be similar to
the following:
<CustomHandleTranslatedItemPipeline>
<processor type="Your.Class2, Your.Assembly" method="YourMethod2" />
</CustomHandleTranslatedItemPipeline>

2. Ensure that the processor method has the following signature:
public void Your.Class2.YourMethod2 (Sitecore.Pipelines.PipelineArgs arg);

3. You can retrieve the following information from the arg parameter:
Information

Description

arg.CustomData
["Database"]
(String)

The Sitecore database that contains the item sent out for translation.

arg.CustomData
["ItemId"] (String)

The identifier of the Sitecore item sent out for translation.

arg.CustomData
["TargetLanguage"]
(String)

The Sitecore language code of the target language.

arg.CustomData
["TargetVersion"]
(int)

The target version of the Sitecore item.

arg.CustomData
["JobId"] (String)

The identifier of the Clay Tablet job that contains the item sent out for translation.
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Information

Description

arg.CustomData
["AssetId"] (String)

The identifier of Clay Tablet asset that contains the item sent out for translation. An
asset can contain multiple Sitecore items, because the Connector aggregates
multiple items into one XML to send out for translation.

arg.CustomData
["AssetTaskId"]
(String)

The identifier of Clay Tablet asset task of the received translation. There is a one-tomany relationship between assets and asset tasks, because one source can be
translated into multiple target languages.

9.4 Using Custom Logic to Overwrite the Workflow Target-Language Setting when
Automatically Sending Items to the Translation Queue via Workflow
The CustomQueueItemTargetLanguagesPipeline setting in CT3Translation.config enables you to
use your own logic to override the target-language assignment when the Connector automatically sends a
source to the Translation Queue via workflow.
The following is a sample implementation of the pipeline:
public class TestCustomQueueItemTargetLanguagesPipeline
{
public void Process(QueueItemsTargetLanguagesPipelineArgs args)
{
Item item = args.SourceItem;
if (item.Language.ToString().StartsWith("en"))
{
args.TargetLanguages.Add("fr-FR");
args.TargetLanguages.Add("es-ES");
}
else
{
args.TargetLanguages.Add("en");
}
}
}

The previous code sample checks the source item to send to the Translation Queue:
If the source language starts with en, then it adds the item to the queue with fr-FR and es-ES as target
languages.
Otherwise, it adds the item to the queue with en as the target language.
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Any implementation should have a method with the signature like:
public void Process(QueueItemsTargetLanguagesPipelineArgs args)

The parameter is of ClayTablet.SC.Pipelines.QueueItemsTargetLanguagesPipelineArgs type:
public class QueueItemsTargetLanguagesPipelineArgs : PipelineArgs
{
public Item SourceItem { get; }
public List<String> TargetLanguages { get; }
}

The implementation can get the SourceItem from the argument, and it can insert target language codes into
the TargetLanguages list of the QueueItemsTargetLanguagesPipelineArgs object.

9.5 Using Custom Logic to Configure how the UploadService Creates Jobs when
Automatically Sending Out Items from the Translation Queue
The CustomAutoSendQueuesPipeline setting in CT3Translation.config enables you to use your own
logic to determine how to automatically create jobs from the Translation Queue. It works in conjunction with
the AutoSendQueueItemsTime option in the ClayTablet.CT3Agent.UploadService agent, which is
described in "Configuring Global Service Settings" on page 47.
The following is a sample implementation of the pipeline:
public class TestCustomAutoSendQueuesPipeline
{
public void Process(AutoSendQueueJobsArgs args)
{
string frJobId = null;
string otherJobId = null;

foreach (TranslationQueueInfo queueItem in args.TranslationQueueItems)
{
TranslationJobInfo jobInfo;
if (queueItem.ItemTargets.Contains("fr-FR"))
{
if (frJobId == null)
{
jobInfo = args.AddNewJob();
// Create a separate job for queue items with fr-FR as target languages
jobInfo.Name = "Auto-sent French job " + DateTime.Now.ToString
("MM/dd/yyyy HH:mm");
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jobInfo.Description = "Automatically send fr-FR in a separate job
scheduled at " + args.ScheduledSendTime.ToString("MM/dd/yyyy HH:mm");
jobInfo.DueDate = DateTime.Now.AddMonths(1);

// You can also specify a certain LSP account to send the job to
// jobInfo.SendAccount = "FR LSP";
frJobId = jobInfo.ID;
}
else
{
jobInfo = args.GetJob(frJobId);
}
}
else
{
if (otherJobId == null)
{
// Create a job for all other queued items
jobInfo = args.AddNewJob();
// Not specify job meta information, the connector will automatically
fill in the information based on AutoSendQueueItems* configurations
// in CT3Translation.config
otherJobId = jobInfo.ID;
}
else
{
jobInfo = args.GetJob(otherJobId);
}
}
// If the queue item's ID is not inserted in a TranslationJobInfo object,
the queue item will be skipped and left in the queue
jobInfo.QueueIdsInTheJob.Add(queueItem.ID);
}
}
}

The previous code sample checks the queued items and creates a translation job named Auto-sent French
job with a timestamp. This job includes all queued items with fr-Fr as one of its target languages. The
Connector's default job contains all other queued items.
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This enables you to submit different queued items in different jobs, and you can send each job using a different
producer key. This also supports sending different queue items at different times, by leaving out some of the
queued items in one invocation of the pipeline and picking them up in a later invocation, using the
args,ScheduledSendTime to determine which ones to send or leave out.
Any implementation should have a method with the signature like:
public void Process(AutoSendQueueJobsArgs args)

The parameter is of ClayTablet.SC.Pipelines.AutoSendQueueJobsArgs type:
public class AutoSendQueueJobsArgs : PipelineArgs
{
public List<TranslationQueueInfo> TranslationQueueItems;
public DateTime ScheduledSendTime;
public List<TranslationJobInfo> TranslationJobsToCreate;
public TranslationJobInfo AddNewJob();
public TranslationJobInfo GetJob(string id);
}

Implementation can iterate over TranslationQueueItems to check all the queued items waiting to be sent
out. The type of ClayTablet.SC.Pipelines.TranslationQueueInfo provides information about the
queued item:
public class TranslationQueueInfo
{
public String ID { get; }
public String ItemID { get; }
public String ItemDatabase { get; }
public String ItemSource { get; }
public int ItemSourceVersion { get; }
public String ItemPath { get; }
public List<String> ItemTargets { get; }
public DateTime CreateTime { get; }
public bool SyncTranslation { get; }
public String SitecoreUser { get; }
}

The implementation should either:
Insert each queued item into a ClayTablet.SC.Pipelines.TranslationJobInfo object, which will
cause it to be sent out as part of the job.
Leave a queued item alone, so it will remain in the Translation Queue for this scheduled automatic sending
invocation.
public class TranslationJobInfo
{
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public string ID { get; }
public string Name { get; set; }
public string Description { get; set; }
public string SendAccount { get; set; }
public DateTime? DueDate { get; set; }
public string SendUser { get; set; }
public List<String> QueueIdsInTheJob { get; }
}

A new TranslationJobInfo is created by AutoSendQueueJobsArgs.AddNewJob(). The implementation
can set the job's metadata, including name, description, sending account (producer key), sending user (the
Sitecore user in the Creator metadata of the job), and due date. Insert the queue item's ID into
TranslationJobInfo.QueueIdsInTheJob. After creating a TranslationJobInfo, the implementation
should typically save it or its ID for reuse when iterating over other queued items that should be added into the
same job. The AutoSendQueueJobsArgs.GetJob (string) enables the implementation to retrieve a
previously created TranslationJobInfo so that it can add more queued items into the same job.

9.6 Using Custom Logic to Populate the Translation Queue
You can now call the <SendToTranslationQueuePipeline> pipeline to put Sitecore items into the
Translation Queue.

To call the pipeline:
You create an instance of the ClayTablet.SC.Pipelines.SendToTranslationQueuePipelineArgs
class to pass to the pipeline as argument.
The SendToTranslationQueuePipelineArgs class is defined in ClayTablet.SC.dll as:
public class SendToTranslationQueuePipelineArgs : PipelineArgs
{
public String SourceLanguage { get; set; }
public String[] TargetLanguages { get; set; }
public List<String> ItemIds { get; }
public int ItemsQueued { get; }
}

This class enables you to specify the source language and target languages for the items, and add Sitecore item
ID into the ItemIds list. The Connector uses the latest source version of the items. When the Connector sends
out content for translation from Translation Queue, it creates new target versions for these items. After calling
the pipeline, you can use the ItemsQueued property to check how many Sitecore items are actually added to
the Translation Queue.
The following is sample code for calling the pipeline:

Clay Tablet Connector for Sitecore Installation and Configuration Guide
Version 3.10.2

Page 95
August 16, 2017

9 Appendix: Connector Extensions

9.6 Using Custom Logic to Populate the Translation Queue

static public int SendToTranslationQueue(string sourceLang, string[] targetLangs,
string[] itemIds)
{
SendToTranslationQueuePipelineArgs args = new SendToTranslationQueuePipelineArgs
();
args.SourceLanguage = sourceLang;
args.TargetLanguages = targetLangs;
args.ItemIds.AddRange(itemIds);
CorePipeline.Run("SendToTranslationQueuePipeline", args);
return args.ItemsQueued;
}
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